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1 MediaBeacon

1.  Welcome to MediaBeacon's Administrator
Guide

Welcome to MediaBeacon’s guide for application administrator-level users of our product.

This guide is divided into two main sections:

• Web UI Configuration, configuration of workspaces, components, and other parts of the
MediaBeacon Web UI.

• Admin Core, configuration of front-end Administrative functions in MediaBeacon.

Using this Guide

• To navigate through this guide, use the # icons to expand the Table of Contents panel, and click the
topic name to read that entry.

• To search across all topic for a text string, use the search field in the upper left corner.
• To download a PDF version of the complete guide, click the “PDF Version” link in the upper right

corner of the page.
• To return to the list of all MediaBeacon documentation, click “Other MediaBeacon documentation” in

the upper right corner of the page.
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2MediaBeacon

2.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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3MediaBeacon

3.  MediaBeacon 21.11 Interface Changes
This section details the new interface updates of MediaBeacon 21.11.

Overview of Nomenclature changes
• In the Administrator menu commands, the System menu has been renamed to Configuration. Other

functions remain the same
 

 

• Saved Selection has been renamed to Save Collection, and alternatively, Load Selection is now
Load Collection. Load collection can be accessed as a Menu bar icon. For more details refer to Save
Collection.
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• Concurrently, the Saved Selection component is updated as the Collections component, and the
Saved Selection in Places Browser as Collections Place.

Figure 1: Save Collection

Figure 2: Load Collection Icon

Menu bar
The 21.11 Menu bar has been focused more on the accessibility of the common features.
 

 

• The users can find the Create button being disbanded and the most used features; Upload and Load
Collection are displayed as icons on the right side along with Notification Center and Cart option.
 

 

Create Menu
• As the Create menu is now disbanded, the Metadata template can be accessed from the

Administrator Menu Commands.
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• Upload command can be accessed via Upload icon on Menu bar. Clicking Upload icon provides the
following options:

• Create Data Asset (Previously Data Asset submenu)
• Upload

• Saved Selection is now Save Collection and users can save asset collection from Selection Bar >
Share > Save Collection.

• Creating workspace can be accessed via Manage > Workspace > Add New Workspace.
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Selection Bar
 

 

• When users make a selection, the Selection bar supersedes the Menu bar.
• Options such as Save Collection, External Portal, External Link, Contact Sheet, and E-mail can be

accessed via the Share menu in Selection Bar (when one or multiple assets are selected.
 

 

• Users can choose to download their assets as either conversion or original by choosing from the
Download command.

• Refer Selection bar to know more on other Selection menu options.

Note:  You may come across old screen-shots on other pages of this guide, we will be updating
those shortly.
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4.  Admin Core
This section covers front-end Administrative functions in MediaBeacon.

What is the Admin Core?
MediaBeacon can be configured on three levels.

1. The Web User Interface, or (Web UI) may be configured by a user with the correct permissions,
usually a Global Administrator-level user.

2. The application's installation itself is configured via the MediaBeacon Server GUI Application
Manual.

3. The Admin Core.

The Admin Core interface is itself a secondary, internal MediaBeacon which uses the metadata of
specialized data-only assets to define system parameters of Users, Groups, Fields, Forms, and Loading
Dock Types. Each of these areas of system configuration has its own Workspace.

Nomenclature
For clarity's sake, this section will use the following terminology to differentiate between some
similarly named concepts:

Because the Admin Core itself is an instance of MediaBeacon, there can be some confusion of
nomenclature. In this section, we will use the following terms to differentiate similarly named points of
configuration

• Web UI: MediaBeacon for non-admin users. Admins may configure Workspaces and Components
here.

• Admin Core: Allows Admins to configure the parameters of Users, Groups / ACLs, Fields, Forms,
and Loading Dock Types.

• Assets

• DAM Asset: An asset that is managed by the Web UI.
• Configuration Asset: An asset managed by the Admin Core that defines parameters of Web UI

behavior
• Fields

• XMP fields: refers to the fields that are used to store data about assets uploaded by users in the
Web UI.

• Property fields: The fields that define the parameters of configuration assets. Also refers to
fields presented in workspace or component configuration.

• Form fields: XMP fields displayed in a Form.
• Configuration value: The values entered into property fields. Often the names of various other

configuration assets will be used as values in property fields.

Admin Core Database
MediaBeacon requires two databases to function properly, one for the Web UI part of MediaBeacon,
and one for the Admin core. The Web UI database can have any name, but the Admin Core database
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must be have the string "_admin" postpended to the Web UI name. For example "mediabeacon" and
"mediabeacon_admin".

See the Database Users section in the MediaBeacon Server GUI Application section for more info.

4.1.  Admin Core Interface Overview

Using the Admin Core

The Admin Core is only accessible to Global Administrator-level users. Once such a user is logged in,
they can access the admin core via the Menubar > Manage > System command.

 Workspace Structure

The interface of the Admin Core is much the same as the Web UI, but tailored to a subset of functions:
creating assets, editing metadata, Quick Search, search filtering and the List view. The following are
interface elements shared across all workspaces of the Admin Core.

Menubar Functions
Many of the menus here have reduced and contextual functionality compared to the normal Web UI.

 

 

• MediaBeacon Logo: Clears all search criteria unless it is configured. For example, it may redirect to
another workspace or perform another arbitrary function. Refer Brand Portal configuration points.

• "Left Arrow" Icon: Returns to the user to the Web UI.
• Navigate: Changes to any of the preset workspaces in the Admin Core.

• Manage: Shows the Administrator Menu Commands.
• Cart Component: Displays the items added to cart.
• Upload: Uploads files via selection or drag and drop.
• Load Collection: Loads the added Save Collections.
• Notification Center: Displays the different kinds of notifications.
• Username: Name of the current user.
• Help Icon: Redirects the user to MediaBeacon University, MediaBeacon's online documentation.
• Quick Search / Search Status components: Functions as normal. Refer Quick Search

Search, Filter and View Assets
On each workspace, the view of configuration assets is restricted to just those pertaining to that
workspace. Users can further search for configuration assets using Quick Search, and/or the search
filter.
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The List view on the right, displays results of search and filter functions. The total number of results is
displayed on the right side of the search status.

Filters at the top of the List view may be used to further filter or sort results.

Search Filter Fields:

• User Workspace

• Username
• User Type
• Primary Group
• Group Membership
• Position
• Active
• State / Region (Not present in versions above 20.2)

• Groups Workspace

• Name
• Users
• Default ACL
• Default Language
• Edit Level
• View Level
• Loading Dock Type
• Visible Forms
• Permission Restrictions

• Fields Workspace

• Name
• Schema
• Type Validator
• UI Element
• Edit Level
• View Level
• Index in R3Search
• Index in SQL
• Synchronization Strategy
• Locale Sorting
• Enable Substring Search
• Dictionary (not present in the versions below 20.2)

• Forms Workspace

• Name
• Display Name
• Class
• Field

• Loading Dock Types Workspace

• Name
• Platform
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• Image Format
• Video Format

Create and Edit Dialogs
The Admin Core does not use the Asset View as the Web UI does, instead each workspace will display a
dialog tailored to the creation and editing of that type of configuration asset.

These dialogs are unlike regular Forms in that they have some dynamic fields, that is, some options
may reveal other configuration fields.

Also, saving behavior is different. All changes must be saved using the lower right-hand button (the
label changes, Create/Update Asset Type).

4.2.  Users Workspace

Configuring user accounts and invitations in MediaBeacon.

4.2.1.  User Account

User Account Overview
User accounts in MediaBeacon control the user's ability to log into the system, define broadly their
level of capability, but rely upon other configurations (Groups, ACLs) to control the fine detail of user
permission.

For an explanation of the interactivity between different types of configuration assets, see the
Configuration Interactivity article.

User Account Workspace List View
• A user account's active status is indicated by a grey flag in the upper left of its row.
• User accounts may be sorted by: Username, User Type, Group Membership, First Name, Last Name,

and Email.
• User accounts may be filtered by: Username, User Type, Primary Group, Group Membership,

Company, Department, Position, Country, State/Region, City, and Active.

User Account Asset Metadata

• Username: The string that the user enters to authenticate.
• Password: The password that the user will enter to authenticate.

• Passwords in local accounts do not have length or character restrictions by default. However
these can be configured, see the [???] article for more information.

• Active: When selected, this option makes the account active, that is, able to log in.
• Change password on next login: When enabled, this option requires the user, once authenticated,

to choose a new password that cannot be the same as the initial password. This is useful if an admin
is asked to manually reset a password, making the password given to a user a one-time password.
Once the password has been changed, this option will be disabled.
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• Note: Both of the Active? And Change password check boxes can be checked concurrently.
• User Type: One of three user types may be chosen here, General User (most users), Group

Administrators (seldom used) and Global Administrator (configuring users). See the [User Type]
section below for more information on these types.

• Group Membership: This multi-value field defines the list of groups to which user has access. It is a
dynamic dictionary field, only allowing currently existing groups to be added.

• The group entered into Primary Group will automatically be entered into Group Membership.
• This is bidirectional with group's Users field. When a group is added to or removed from this

field, this username will be added or removed from that group's Users field.
• Loading Dock Type: Assign the loading dock type for

• Primary Group: This field is an artifact of legacy systems, and the group listed here has no special
function or bearing on the account. There are a few quirks about how it is used in the Create / Edit
dialog:

• It is a required value, and the value here is automatically added to the list of groups in Group
Membership.

• When a user is created, it is auto-populated with the "users" group. This is usually not desirable.
See the Groups Workspace on page 22 section for more information.

• The best practise to use when populating a user:

• Single group: the group to which the user belongs will be in Primary Group and Group
Membership fields.

• Multiple groups: All groups will be in Group Membership, but one of them (it does not matter
which) must be in Primary Membership.

• User Account Contact Fields: These fields have limited functionality within MediaBeacon, and do
not need to be entered for an account to be valid.

• First Name: If filled, the string here will be displayed in place of the username field when the
user is logged in.

• Last Name: If filled, the string here will be displayed in place of the username field when the
user is logged in.

• Company
• Department
• Position
• Address Line 1
• Address Line 2
• City
• State/Region
• Zip Code
• Country

15
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• Phone Number
• Phone Extension
• Email: This field must be filled out, otherwise the system cannot send email to them.

• Content Pools: This function extends per-user information and metadata search capabilities. See
the Content Pools article for more information.

Local vs IdP Users

Local vs IdP Users
User Accounts can be thought of in two major categories. One, local accounts, which are created and
managed by the MediaBeacon system itself, and identity provider (IdP) accounts, those controlled by
an identity provider that MediaBeacon is configured to use. MediaBeacon integrates with an array of
identity providers. See the Enterprise Tab section for more information.

Local Accounts

This article refers to local account functionality in general, and IdP accounts as noted.

IdP Accounts

This section will list those areas where IdP accounts differ from local accounts

• Username and Password: Controlled by the IdP and are not editable.
• User Account Contact Fields: Controlled by the IdP and are not editable.
• Active Setting: An IdP account can be prevented from logging in when its Active option is

disabled. The user authenticates as normal via the IdP, but no access is granted to this account.
• Primary Groups and Group Membership: These fields in an user account are generally controlled

by the IdP and are not editable. Configuration options do exist to change this behavior, allowing
the IdP to initially populate these fields, with MediaBeacon allowed to make changes

User Type (User Levels)

• General User: This type of user has no access to configure the Admin Core, and is granted the
ability to configure parts of the Web UI in only very exceptional circumstances. Most users of the
system will be this type.

• Global Administrator: This type of user has the most power to edit configuration in the system,
always having access to the Admin Core, and to Admin Mode. Some group/ACL permission
restrictions can limit the abilities of global admin, so it is worthwhile to ensure there is at least
one fully unrestricted group set aside for this purpose.

• Group Administrator: The group administrator capabilities fall somewhere between the General
User and the Global Administrator.

• Cannot use Admin Mode.
• Full access to Admin Core.
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• For this reason, this user type is not often used. Typically, intermediately permissioned users
will be of the General User type, and given access to groups that allow more capability them
most other users.

User Invitations
MediaBeacon's invitation system is a way to quickly on board a number of local users with a minimum
of Global Admin effort. An invitation creates an email, link, or activation code that gives a users a self-
service method of account creation. One notable difference between invitations and normal user
accounts is that invitations are not stored as XMP assets, and as such have limited edit-ability once
created.

Users created by an invitation does not count or counts against the number if users a given license
allows. For more information read the license parameters.

Creating an Invitation

Once the Menubar > Create > Invitation command, is chosen, the Invitation dialog is shown. It's titled
"Activation Code: ".
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ALERT CALLOUT: This number is both the key for creating accounts, and identifying them for later
management so it may be worth copying before filling out the below form.

• Number of Users: The maximum number of users that can be created by a given invitation.

• Email Details: Sending an email is optional. If so the Activation code or link will need to be
copied by hand. It's recommended that global admins send the invitation email to themselves for
forwarding even if they are not going to designate recipients initially.

• To: Allows one or more (comma separated) email addresses to receive the invitation email.
Unlike other email forms in MediaBeacon, this one does not prefill user accounts / email
addresses as it is assumed the recipients are not already in the system.

• Subject: Standard email functionality.

• Body: Standard email functionality. Will also contain the link to complete an account
activation when sent.

18
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• Default Group: The invitation system allows the user to choose one group the users will
belong to. If more than one group is needed, this may be added to users via normal editing or
bulk edit once they have created their account. This field cannot be left blank.

• Required Fields: In addition to a username, the User Account Contact fields may be set
to required, for the invited user to supply. It's recommended to include "Email" with every
invitation.

• Create Invites and Send Email button: The To and Subject lines will need to be filled to send an
email properly.

• Create Invites: Immediately creates the invitation, displaying the "Email Users" dialog, to remind
the admin to send the activation link to users.

ALERT CALLOUT: This is the only time that the link can be copied at this point. Double check it has
been completely copied. Clicking "OK" or "X" clears the dialog.

Managing Invitations

Once created, an invitation's status can be reviewed by clicking the Menubar > Manage > Invitations
command, opening the Invitation User Summary dialog

• Invitation Name: Unique Identifier for each invitation.

• Activation Code: The code as seen in the "Activation Code" dialog. This is the easiest cross
reference to each invitation.

• Invited Users: Number of users initially invited.

• Remaining Users: Remaining users for the given.

• "X" (Delete) button: This will delete the invitation.

Using an Invitation

Via Link
When the user follows an activation link, the user is redirected to the MediaBeacon site:

1. The Create Account dialog is displayed.
2. The user enters required fields and clicks "Create".
3. If the account is successfully created, the "Success" dialog is displayed, the user then clicks "Close"

to return to the MediaBeacon login screen.

Via Activation Code
The activation code from an invitation may also be used to create accounts to be used, but the "Create
Account" link option must be enabled in the Log In component on the Log in workspace. For more
information on how to enable this function.

To use, the user clicks the "Create Account" link, displaying the "Enter Activation Code" dialog.

1. The user enters the activation code, and clicks "Create". If the activation code is valid, the steps of
account creation above in "Via Link" are followed.
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INFO CALLOUT: The activation may also be postponed to the following string to make an activation
link: "http://externaltraining2.mediabeacon...tMain.html#!CU"

4.2.2.  User Types

User Types are the different kinds of users who can access MediaBeacon.

There are three types of users

• Global Administrator: User with full control over MediaBeacon. Global Administrator configures
other users.

• Group Administrator: User with access less than administrator but more than General Users. Their
control will be limited to the group they are part of.

• General user: User with access to the basic functionalities. General users do not have access to set
up configuration.

Users access to MediaBeacon depends on the User type they are assigned by the Global Administrator.

20
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Administrator Menu Commands
Each User Types have different access to Administrator Menu Commands.

Figure 3: Global Administrator

Figure 4: Group Administrator

Figure 5: General User

Below table shows the basic functionalities and the corresponding access for the User Types.
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Permissions Global Administrator Group Administrator General User

Login Yes Yes Yes

Create and modify
assets

Yes Yes Yes

Search Assets Yes Yes Yes

Download Assets Yes Yes Yes

Create Collections Yes Yes Yes

Share Assets Yes Yes Yes

Create External Portal Yes Yes Yes

Edit all Components Yes Yes

Admin Core Access Yes Yes

Create Workspaces Yes Yes

See all groups they're
part of in admin core

Yes Yes

Edit all groups they're
part of in admin core

Yes Yes

See all users that are
attached to groups they
are part of

Yes Yes

Manage Workspace Yes Yes

Create Users Yes

Create/Edit Groups and
ACL

Yes Edit groups they’re part
of

Edit/see users Yes

Edit/see forms Yes

Edit/see fields Yes

Edit Conversion types Yes

Duplicate users and
groups

Yes

Configure the system Yes

4.3.  Groups Workspace

Configuring Groups and ACLs in MediaBeacon.
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The Groups workspace in the Admin Core allows admins to create and edit groups and ACLs.

 Groups Overview

Groups in MediaBeacon are organizational objects that users can be assigned to. Each group can
impart specific privileges to users, such as access to certain functionalities, or access to specific
assets. Conceptually,MediaBeacon groups are roughly analogous to the groups that an identity
provider (IdP) defines.

ACL Overview
MediaBeacon adds an additional layer of configuration for flexibility: the Access Control List or
ACL. ACLs control a key set of users' capabilities in the system. ACLs are not inherited from Identity
Management systems, being a MediaBeacon-exclusive configuration.

ACL configuration will be covered in the Configuring ACLs article, but organizationally, they are
subordinate to groups. Refer ACL Configuration on page 26.

Group Asset Metadata

• Name: The label used for the current group.

• The Group name is usually not visible to users, except when sharing a Saved Search or Saved
Selection.

• Hidden?: Enabling this option hides the group in the Group workspace's List View. When groups
are hidden, the Search Filter will display the Hidden facet, and clicking True will show the hidden
groups. This setting is often used when an IdP imports a large number of unused groups into the
system.

• LDAP DN: Although labeled "LDAP", this field inherits the Domain Name that is supplied when
importing a group from an IdP.

• Description: A text description of the group, only visible in the Admin Core.
• Login Message: This field is used to add text to the Login component shown on the login

workspace. It has a number of limitations:

• As this is a group-based property, it will only be displayed after a user logs out from a specific
group.

• A record of what group the user was in when they logged out is stored in a browser cookie.
• If a user has never logged into MediaBeacon, or has removed browser cookie, this message will

not be displayed.
• Users: Displays the current members of the group. Users may also be added to a group by adding

their usernames here.

• This is bidirectional with a user's group metadata. When a user is added to or removed from this
field, this group will be added or removed from the user's Group Membership field. If the user has
only one group (that one group being present in both Primary Group and Group Membership), the
"Default" group will be automatically added.

• Loading Dock Type: Assign the loading dock type for the group. All ACLs within this group will share
this setting. See the [Loading Dock Type] section for more information.

• Loading Dock Quota: Set the maximum number of megabytes that a group user's Loading Dock
can hold. All ACLs within this group will share this setting. See the [Loading Dock Type] section for
more information.
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• Default Language: Sets the default language the Web UI will use upon initial login. All ACLs within
this group will share this setting. See the [Languages] section for more information.

• Edit Level and View Level: These settings control what metadata fields can be edited or viewed by
users in a given group. The levels range from 0 (lower) to 9 (higher). All ACLs within this group will
share this setting.

• These levels carry no inherently different functions, instead being relative to the corresponding
settings defined for each field. If a group's Edit level is 5, all users (using that group at the time)
will be able to edit fields at levels 0 through 5. The same goes for the View level, a field is visible
to a user if the ratings correspond.

• Edit Levels are overridden by the Edit Metadata permission restriction. When set, the user
cannot write metadata.

• It is important to remember that the view and edit levels do not provide access as much as they
limit it. These settings are of limited use if the user is not first granted the ability to see a given
field via the Visible Forms setting.

• Below are some examples of caveats with these levels. The examples assume the field edit/view
levels are set higher than the user's current group's levels.

• Fields on a Forms will be non-writable or hidden, respectively.
• List View columns (defined by fields) will not be hidden by View level. Edit level will prevent

writing to these fields.
• Fields used in the Search Filter will be hidden.
• A field used in the Taxonomy component is always visible and editable.

• Priority: A ranking system of 1-20 (20 being the highest) to determine a user's "login destination",
that is, the Group, ACL and workspace the user is automatically directed to upon login.

• The system also ranks groups differently based upon the Default ACL setting. If this field is
blank, that group will always be considered lower priority than any group that has a defined
Default ACL. For example, a group with Priority 1 and a Default ACL defined will be the login
destination even if that user has access to a group with Priority 20 and no Default ACL.

• Default ACL: The ACL to which the user is directed upon login by default if there is more than 1 ACL.
This is contingent upon the user's group's Priority setting.

• ACLs section: This area lists the ACLs that have been defined for the current group. Click the "Add"
button to add an ACL section. See the ACL Metadata article for information on these settings.

• PDF Title Template: This section allows the user to set a cover page for PDF files generated by the
Contact Sheet functionality.

• Note that all ACLs in a group will share the came cover page.
• See the How to Create a Custom Contact Sheet Cover Page article for more information.

4.3.1.  Managing Groups with an IdP

When using an IdP with MediaBeacon, group management will have some differences.

Upon user authenticates against the IdP:

• A user account configuration asset is created if it does not already exist. The user account
configuration asset will then sync metadata the IdP supplies.

• Group configuration assets are created for all groups of which the user is a member, if they do not
already exist. Those group's configuration assets will then sync metadata the IdP supplies.
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• The metadata synced to groups is limited: "Name" is always present, "LDAP DN" maybe supplied,
and any users who have previously authenticated who are part of the IdP group will be listed in the
"Users" field. The IdP supplies no other metadata fields or ACLs, so these will need to be added in
MediaBeacon.

• Pre-Existing MediaBeacon groups can be synced to an IdP after they have been created. All that
is required is to match the names of theMediaBeacon groups to those of the corresponding IdP
groups prior to user authentication.

• User's membership in groups must be managed in the IdP system.

User / Group Assignment with IdP

In default configuration, MediaBeacon does not have the ability to change the assignment of users
to groups, as this is wholly managed via the IdP itself.

Using an optional configuration, MediaBeacon can be allowed to edit user membership of IdP
groups.

If an ACL is not configured for a group, the user will be shown a dialog: "Warning, No ACLs available.
Please contact your administrator."

4.3.2.  Monitoring

The Monitoring user/group is configured to check system performance and health of MediaBeacon
instance's various internal sub-services. An alert is issued to our internal teams for further
investigation if an anomaly is detected in one of these services.

Monitoring ensures these sub-systems to prevent the users from having a service disruption. By
default, this is enabled for all MediaBeacon installations. Contact Customer Care for more information
or support.

For MediaBeacon 21.03 and before versions, the users can manually create a new user or assign an
existing user to monitor the system while setting up.

Note: The users are recommended not to modify these changes.

The Monitoring feature in the MediaBeacon 21.07 and later versions is designed to load automatically.

A separate User account, ‘’Monitoring” will be added by default, in order to authenticate the Monitoring
feature.

The new default user belongs to the Monitoring group and has limited access. A random password and
the API key are also generated by default.
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Note:  The password, as well as the associated API key, is unique and is randomly generated when
MediaBeacon is installed.
 

 

Note:

• The permissions for the Monitoring group are limited to monitoring and other actions are restricted.

4.3.3.  ACL Configuration

Configuring Access list in MediaBeacon.

• ACL Metadata is contained in a group configuration asset's metadata, but for the sake of clarity it is
described here.

ACL Metadata is in the Data Block metadata structure.

• Name: The label of the of the current ACL. Note that general users do not see the names of
groups in the ACL menu, only the string designated in this field.

• Default ACL checkbox: Enabling this option automatically copies this ACL to the parent group's
Default ACL field.

• Description: A note area to describe the ACL. This string is only displayed in this field and in the
ACL Selection component.

• Root Path: This field designates a "root folder" to filter assets available to ACL users. When
set, the user of the ACL will only have access to assets that are contained in that folder and
subfolders. Can be used in conjunction with the "Search Filter" setting, below.
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• This is noted in the Web UI as "Index/", in the Directory Browser, Move/Copy dialog.
• "Index" does not always refer to an ACL Root Path. See [The Index Folder] Article for more

information.
• Hide: When enabled, this setting will prevent this ACL from being listed in the ACL menu or the

ACL List in the Places Browser. This may be desirable in the case of an IdP pooling all users into
a common group.

• Icon: Defines the icon displayed for this ACL in the ACL menu and the ACL Selection component.
• Workspaces: This field lists workspaces this ACL can access. The user cannot add workspaces

here, but they can be removed.

Note:  If a workspace is removed and it is not shared by any other ACL, the workspace is
permanently deleted.

Search Filter: This field designates a saved search to filter assets available to ACL users. Similar
to the Root Path, this will restrict the user's access. However, instead of the restriction being the
contents of a folder, the assets returned by the search are available to users.

• Can be used in conjunction with a Root Folder, as described above.
• The Search Filter dropdown lists all non-private saved searches to be used as an ACLs search

filter. Best practice is to create "Admin Searches" for use in ACL configuration. See the [???]
section for more information.

• Upload Form: This field allows a specific Form to be designated as the default upload Form for all
workspaces in that ACL. Note that the Upload Form designated for a workspace or component will
override this setting.

• Javascript on Download: Client-side Javascript entered here will be executed prior to allowing the
download of a file. This option is usually only required for add-on products.

• Permission Restrictions: Entries in this field suppress the specific functionalities for users of this
ACL. This field is multivalue, and can clear all or add all restrictions with the buttons below it. Please
see the [Permissions Restrictions List] article for full detail on specific restrictions.

Note:  If a permission restriction is listed in this field, the functionalities associated with it are
disabled for users of the ACL.

• Permission Workflows: This field designates an advanced workflow that can automatically and
dynamically set permission restrictions for the ACL.

• This allows a server side script to be called to check if the permission should be enabled or not.
For example, you could have a conditional permission based on metadata or call an external
rights management system.

• Conditional Download: This field allows a saved search to be used to restrict download of assets
based upon metadata.

• Assets that are the returned by the designated search will be downloadable, all others will still be
accessible but cannot be downloaded.

• The "View Original", "Crop", and "Check Out" commands are also unavailable in this case.
• Best practice is to create "Admin Searches" for use in ACL configuration.

• Visible Forms: This field defines what Forms are available in the Bulk Edit or Asset View interfaces.
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• Changed from previous versions of MediaBeacon, newly-created Forms are not automatically
added to all ACLs Forms are now "opt-in" within the ACL configuration.

• GWT JS, GWT CSS, and GWT Body: Code entered here will be added to all served pages in
MediaBeacon.

Editing ACL Settings
As ACLs are metadata contained in a group, ACLs are edited within a group's Create/Edit dialog. Each
ACL section no longer has an independent "Save" button, all changes to all of a group's metadata is
saved when the "Update Group" button is pressed.

Permission Restrictions List

Note:  A comprehensive guide to Permission Restriction functionality.

The Permission Restriction field is a multivalue field in each ACL that lists a set of "tags". Each of these
define set of functionality that suppressed by inclusion on this field.

The "Add All" button will add all permission restrictions to the list, and the "Clear" button removes all
permission restrictions.

Note:  When a permission restriction is added to an ACL it PREVENTS a user from using a particular
functionality.

• Add Annotations: Prevents the user from adding or deleting items in the Discussions Form tab in
the Asset View.

• If the View Annotations permission restriction is enabled, the Discussions tab is not visible,
preventing the user from adding discussion items, making this permission restriction redundant
in that case.

• Add Placeholders: Prevents the user from creating data-only assets. If the File Action permission
restriction is enabled, the user will not be able to create placeholder assets, making making this
permission restriction redundant in that case.

• Administer Bundles: Prevents the user from creating and editing bundle status. Users will still
be able to edit metadata in bundles (even bundle fields) if given access to those fields. This is
considered an Admin privilege, and the Configure Widgets permission restriction should be set for
most users.

• Administer Dictionaries: Prevents the user from creating, editing, or deleting dictionaries. This is
considered an Admin privilege, and the Configure Widgets permission restriction should be set for
most users. Note that when a user can administer dictionaries, they can do so for all dictionaries in
the system.

• Allow Quick Download: Prevents the user from using the Quick Download feature .

• Note: If the Download Hi-Res permission is enabled, Allow Quick Download is redundant.
• Archive / Restore: This permission restriction is deprecated, and has no function.
• Change Password: Prevents users that have local accounts from changing their passwords,

contact info, and email settings.
• Check Out: Prevents the user from using the Check Out functionality.
• Check Out Admin: Prevents Global Administrators from using the "Check In" and "Cancel Check Out"

commands and downloading checked out assets.
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• Configure Widgets: Prevents the user from accessing component's configuration panel. This is
considered an Admin privilege, and the Configure Widgets permission restriction should be set for
most users.

• Contact Sheet: Prevents the user from creating contact sheets.
• Content Pools Filter: This permission restriction is deprecated, and has no function.
• Custom Download: Prevents the display of the "Custom" tab in the Conversions dialog. If the

Download Hi-Res permission restriction is enabled, the user will not be able to use Custom
Download, making this permission restriction redundant in that case.

• Delete Access: Prevents the user from using the Delete command.

• If the File Action permission restriction is enabled, the user will not be able to use the Delete
Command, making this permission restriction redundant in that case.

• Desktop Drag and Drop: This permission restriction is deprecated, and has no function.
• Download Hi-Res: Prevents the user from download non-converted original) files. In addition it

also:

• Prevents use of the Quick Download function.
• Prevents use of the Custom Download tab.
• Prevents use of the View Original command.
• Prevents attaching assets to Email.
• Makes redundant the Allow Quick Download and Custom Download permission restrictions

• Edit Metadata: Prevents the user from editing any metadata. This permission restriction ignores
field and group Edit Level settings. Note the following caveats:

• Non-directly editable metadata will still be changed if the user performs other actions, such as
uploading a new file. MediaBeacon will add any metadata that is included in the file, as well as
metadata such as file size and Modification Time.

• Does not recapitulate the Change Password permission restriction.
• Enable Contextual Menus: Prevents the user from accessing contextual menus. Note that a Global

Administrator user will always be able to access the Admin Mode via a contextual menu.

• When this permission restriction is used, the following commands will be unavailable.
Commands that may be accessed elsewhere in the interface are marked with an asterisk (*).

• Open in New Window
• Copy Link
• Quick Download (also available in asset upper-right pulldown buttons)
• Download*
• Selection (The main selection menu
• Add to Cart (Drag, Menubar > Selection > Add to Cart
• Pinpoint Text*
• View Original*
• Replace
• Crop
• E-mail*
• History (also available in the Menubar > Manage menu, if user has access)
• Check Out, Check In, Cancel Check Out
• New Version
• Views
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• File Action: Prevents the use of the Move, Copy or Delete commands. Also prevents renaming
assets, creating data-only assets, and hides the Create Menu. This permission restriction makes
redundant the Add Placeholder, Delete Access, Rename Asset permission restrictions.

• File Upload: Prevents the user from uploading new assets toMediaBeacon. This does not restrict
the Import, Replace, Check Out, or Versioning functions.

• Folder Action: Prevents the user from using various commands on folders. The following
commands in the Directory Browser and Places Tree Directory Place contextual menus are
disabled.

• New
• Rename
• Delete
• Move/Copy
• Duplicate Folder

• Generate External Links: Prevents the user from using the External Links command in either the
Create or folder contextual menus. Note: This function may or may not be considered an Admin
function, and as it allows access to assets without login or authentication, care should be given in
determining which users can use External Links.

• Import Assets: Prevents users from using the Import command on assets or folders. This is
considered an Admin privilege, and the Configure Widgets permission restriction should be set for
most users.

• Link Assets: Prevents the use of the Link Assets functionality. Note that this is a wholly different
function from External Links.

• Manage Workspaces: Prevents the user from changing workspace settings, as well as adding /
removing components, rearranging workspace tab order, setting workspace tab names, and
changing the the layout their workspaces. This is considered an Admin privilege, and the Configure
Widgets permission restriction should be set for most users.

• Maximize/Minimize Widgets: This permission restriction is deprecated, and has no function. This
was removed in MediaBeacon 2019.1

• Rename Assets: Prevents the user from renaming assets. This permission is redundant when the
File Action permission restriction is enabled.

• Replace Assets: Prevents the use of the Replace functionality.
• RSS: Allows the Global Administrators to have access to RSS functionalities, listed below. In

MediaBeacon 2018.x and 2019.x, this functionality is not enabled, so for those versions this
permission restriction is effectively deprecated.

• Manage > "Feeds"
• Directory Browser "Create RSS Feed" and "Attach RSS Feed"

• Send E-mail: Prevents the use of email-related functions:
• Thumbnail Deletion: Prevents General Users from deleting icons in the standard icon picker

interface. Added in 2019.1.
• Trigger Workflow: Prevents a user's actions from triggering custom workflows. Visual Workflows

(VWFE) and Advanced Workflows require this privilege to be unrestricted to operate in a given ACL.
The Adobe® Connector is prevented from being usable in an ACL when this permission restriction is
used.

• Upload Anywhere: Prevents uploading to any directory other than the standard directory.
• Version: Prevents the use of the Versions functionality. This permission restriction has no bearing

on the Check Out functionality, which also creates versions in MediaBeacon.
• Video Original: Prevents access to the original video file as opposed to renditions with lower frame

rates, more compact formats, etc.
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• View Annotations: Prevents display of the Discussions Form tab. When this permission restriction
is enabled, the Add Annotations permission restriction becomes redundant. Global Administrator
users may always use this function, regardless of setting.

• View Global Asset Log: Prevents users from accessing the History command.

• ACL Permission Restriction on External Portal: This feature is enabled by default for all users of
an#ACL but#may hidden by using the “External Brand Portal” permission restriction

• ACL Permission Restriction on Metadata Template: This feature is enabled by default for all
users#of an#ACL but#may#hidden#by using the#“Create Metadata Template”#permission
restriction.

• External Brand Portal: When added to the “Permission Restrictions” field of an ACL, the ability to
create and manage External Portals will be unavailable to all users of that ACL.

• Approval: Prevents to enable the approval process.

Renaming Downloads
In MediaBeacon 21.11, the administrator can enable renaming assets to any of the field names when a
download has been made.

For example, if users need to track the downloaded assets using their File size or Date, Rename On
Download can be set to File size or Date.

This feature can be restricted to a certain Group/ACL.

The administrator should edit a group’s metadata enabling Rename On Download.

1. Navigate to Manage > Configuration > Groups
2. For already existing groups, click on the name of the group. While creating a new group, click on

Create > New
3. Go to ACLs > Rename On Download
4. Select a field from the list in Fields To Use
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Note:  For the above example, if there are no keywords in this certain ACL, users can add another field.
While downloading, the assets will be renamed to either of the selected fields.

Note:  Assets shared via External Portal automatically renames to the field selected, if Rename On
Download feature is enabled.

4.3.4.  Contact Sheet Cover Page

How to Create a Custom Contact Sheet Cover Page
Administrators can define a custom contact sheet cover page on a per-group basis. In the example
below (the default cover page in MediaBeacon 2018.X and 2019.X), only the text strings "Title Field" and
"Description Field" are dynamic. These are designated per contact sheet created in the Create Contact
Sheet dialog.

• The file used as a cover page is a single-page PDF.
• If inheriting the Title and Description strings is desired, the PDF file must include specifically-

named form field elements.
• The only way MediaBeacon effects the deign of this page is to supply the values (strings) of the Title

and Description field.
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Creating a Contact Sheet Cover Page

1. Create a design.

a. A tool like Adobe® InDesign works well for this, as it can natively create PDF files, but any PDF
is a valid source. Please note that the fields that will be filled in are not designated at this
time, this is done later with Acrobat Pro's form field functionality.

b. It is recommended to create a cover page in standard Letter size (8.5" x 11").
c. Save a PDF of your design.

2. Open that PDF in Adobe® Acrobat Pro.

a. Any version of Acrobat able to create and edit form fields can be used. This guide shows
Acrobat XI Pro, 11.0.23.

3. Go to View > Tools > Forms.
4. The window will go into Form Editing Mode.
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5. Choose “Create", and the "Create Form" dialog will be displayed. Choose "From Existing

Document", and press "Next >".
 

 
6. The "Existing Form" dialog is displayed. Click "Current Document" and then "Continue".
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7. If there are any empty frames (as in the example) Acrobat will attempt to create form fields. This

is an OCR- like process by Acrobat and not always exact, so some hand-adjustment is required.
 

 
8. Adjust the of the size and placement of these fields to align to the frame edges. Then, right-click

a field to edit its properties.
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9. In this dialog, designate one field "CatalogTitle" and the other "CatalogDescription". The Name

and Tooltip do not need to match, but it's best practice to have them match or to leave the tooltip
blank. See the Appendix for more from field properties.
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10. Save the PDF.

a. Note: these fields can be further customized in Acrobat by setting font, text size, and
paragraph formatting.

Configuring a Contact Sheet Cover Page

Contact sheet cover pages are assigned on the Group level in MediaBeacon. Note that there are
configuration differences between 2018.x and 2019.x.

MediaBeacon 2019.X Configuration
1. Log into MediaBeacon as a Global Administrator user, and go to “Manage > System", then to

"Navigate > Groups."
2. Double-click the icon of the group you wish to edit. In the Edit Group dialog, next to "PDF Title

Template" (an older name for the contact sheet cover page) click the "Upload" button and choose the
PDF from above, and click the next "Upload" button.
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3. If necessary, the custom PDF may be cleared with the revert button to the right of the Upload

button.
 

 
4. Click “Update Group”, and leave the Admin Core.
5. Once all users who are members of the group have logged out and back in again, the new coper

page will be used for Contact Sheets.

MediaBeacon 2018.X Configuration

This version of MediaBeacon does not have a UI-based approach. In 2018.x, a custom contact sheet
cover page can be defined as a group specific cover page or as a fallback.

1. Set system property. This defines the "template location" folder, within which the system will look
for cover pages. The folder specified is the recommended location, and is relative to <Shared
Files Directory>/m-userinfo/

mb.pdf.template.location="/m-templates/pdf/"
2. After this property is set, MediaBeacon must be restarted.
3. Name Cover Page Files.

a. The names of PDFs residing in the "template location" directory affect their function. No
restart of MediaBeacon is required when new cover pages PDF files are added or changed in
this directory, as MediaBeacon checks this directory each time a catalog is made.

b. Default (Fallback) Cover Page: This will be used when a group has no specific pdf specified.

a. pdfCoverpage.pdf
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c. Group-specific Cover Page: This will be used for a given group, replacing the string
"groupname", without the "<>".

a. <groupname>.template.pdf

Appendix

Text Field Properties in Acrobat Pro

Appearance Tab
 

 

• Borders: If your design did not start with boxes as graphic elements, you can add a border to text
frames directly.

• The "Font Size" property may be set to "Auto". If this is set, the text this box inherits will scale in size
to fit the box. If this is not desirable, set the Font Size to a static value.

• Font may be set here to provide a consistent look in your forms. It is not recommended to use
custom fonts that are not likely to be on the user's system.

Position Tab
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• If necessary, very fine adjustments to size and position of fields can be made here.

Options Tab
 

 

• Alignment can be set here.
• Default Value: leave this blank.
• Check Spelling is not required.
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• Multi-line will align text to the top of the field, allowing text to wrap. If this is off, the text will appear
vertically centered in the form field and will be truncated if the string size exceeds the box size.

• Scroll long text: Only useful if the PDF on a computer.

Creating Form Field PDFs Directly From InDesign
Adobe® InDesign can be used to create a PDF with form fields, however, pertinent field properties will
still need to be edited in Acrobat Pro (Font-Size, Font, Check Spelling, Multi-line, and Scroll Long Text).
This technique is most useful to create form fields in exact positions.

In InDesign:

1. Add Window > Interactive > Buttons and Forms to your toolbar.
2. Choose a frame to make into a form field.
3. In the Buttons and Forms panel, choose Type: Text Field.
4. Enter the correct name of the Field.
5. Note: The multi-line and scrollable options can be adjusted here.
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6. Save the INDD file.
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7. Choose File > Export, and choose format "Interactive PDF".
8. From here, edit the properties of the fields as necessary in Acrobat Pro.

4.4.  Fields Workspace

Defining XMP fields in MediaBeacon

The Fields workspace defines each XMP metadata field in MediaBeacon using a specific field
configuration asset and metadata in that asset defines the parameters of the field.

This interface for configuring fields has changed greatly from previous versions of MediaBeacon, as
well as some nomenclature used. Notably the concept of schemas has changed:

• No Schema Tabs: In past versions of MediaBeacon, a schema (aka URI: Universal Resource
Identifier,) was created as a framework for subsequently creating fields. Current versions of
MediaBeacon allow independent creation of fields, although a URI must still be defined.

• No Auto generated Forms: Each schema automatically generated a Form, but these were not fully
editable. Current versions of MediaBeacon do not autogenerate Forms for fields, preventing a
proliferation of unused Forms.

Note:  Even though new Forms are not automatically generated for schemas, new Forms can be
created from schemas as an option while creating a Form.

• No Namemapping Tab: Fields no longer need to be "namemapped" as each field has a "display name"
field.

4.4.1.  Field Configuration Asset Metadata

• Schema: The identifier that all fields in a schema share.
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• Background

• In the XMP standard, this is referred to a "namespace URI"

• Best Practices:

• Currently is less enforced in MediaBeacon than previous versions, it is generally desirable to
have a small number of schema for fields created for private use by an organization.

• Example:

http://ns.companyname.com/en/packaging/administrative/1.0/

• Protocol: Many URI's begin with "http://", but there is no commitment that they be resolvable
web resources. The "ns.", therefore denotes this as a namespace, not web page.

• Organization Name and top level domain: "companyname.com/"

• Descriptors: "/en/packaging/descriptive" - This can be any number of descriptive identifiers
that characterise the use of the schema as a whole, in this example "/en" identifies that
the data is in English, "/packaging" identifies the fields are packaging related, and "/
administrative" might indicate metadata that is not intended for general users.

• Version "/1.0": a number that will identify the version of the schema, "1.0" is standard.

• Ending slash: "/" this is mandatory on all schema names.

• Allowed characters: a-z, A-Z, 0-9 (as long as a number is not the first character in a string),
hyphen "-", and underscore "_". Spaces are not allowed.

• Internal Name : This is the canonical name of the field, which is the data structure written into XMP
and the field's name as it is stored internally in the database.

• Background:

• In the XMP standard, referred to as the "local name".
• Technically, fields are properly referenced to using the XML Expanded Name, composed of

the namespace URI and the internal name).

• Best Practices

• Allowed characters: a-z, A-Z, 0-9 (as long as a number is not the first character in a string),
hyphen "-", and underscore "_".

• Spaces and slashes "/ \"are not allowed.

• Display Name: Display name is the default string used to identify a field in the interface, or the
name as it is displayed to end users. It can contain any UTF-8 character.

• Background: This is what used to be referred to as a Namemap or Field Label.

• Type (aka Type Validator): This defines the type of data allowed in a field. See the Field Types
section for more information on the settings available

• UI Element: This setting defines a field's presentation in the interface. See the Field Types section
for more information on the settings available.

• Required Edit Level: This setting controls a field's edit-ability compared to a user's group's Edit
setting. The group setting must be equal to or higher than a field's setting for a user of that group to
edit it. Ranges from 0-9.
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• Required View Level: This setting controls a field's visibility compared to a user's group View
setting. The group setting must be equal to or higher than a field's setting for a user of that group to
view it. Ranges from 0-9.

• Index SQL: When enabled, this option will index this field (all values in all assets) as a SQL table The
main benefit of this function is that it would allow the field to be used as a Highlight or as an Import/
export Key field.

• Background: By default, MediaBeacon allows up to 29 "String," 10 "Date," and 10 "Integer"-type
fields. This can be increased but requires a modification to SQL database settings. A number
of predefined fields in MediaBeacon use indexing, so the numbers above do not indicate the
number available for use.

• Best Practice: There are very few reasons to SQL index a field in current versions of
MediaBeacon.

• This setting allows a field to be used in View component's Highlight config.
• This setting allows a field to be used as a Key Field in the Import/Export Wizard.

• Index in R3search: This option allows a field to be searchable in MediaBeacon.

• Best Practice: The setting here may be 100kb or 1Mb of metadata per file that is indexed.

• Synchronization Strategy: Will affect how a field's data is written to the SQL database and into
Asset XMP.

• Best Practice: Although Asynchronous is generally recommended, overview of different
strategies would be helpful

• Display Order: The number here will determine the display order of the field. This field has no
function other than when defined in a Form, and is not inherited when a fields is placed in a Form.

• Best Practice: Safe to leave blank.

• Locale Sorting: Changes rules for the alphanumeric sorting of a field's data in the Web UI,
according to the sorting rules for the specified language.

• Default Value: A value entered here will automatically be pre-filled to the field whenever it is blank
in a Form.

• Best Practice: This is best left blank in Field configuration, to be used primarily in Form
configuration.

• Substring Searching Allowed: When enabled, this option allows a field's value to be searched on a
substring level

• Background:

• Without this option, MediaBeacon's standard behavior is to break space delimited data into
"whole words". So, normally, a search for "great" will return an asset that had a Keyword of
"super great".

• Enabling the substring option is only needed when it is desirable to return an asset
containing the value "aubergine" when a search for the strings "gine" or "berg".

• Best Practice:

• While of moderate impact on most fields, enabling this option on a field that contains
paragraphs of text over hundreds of thousands of files may create unnecessary load on the
system.
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• Not Empty:The field value must contain a value for a Form containing that field to be saved.

4.4.2.  Field Type and UI Settings

A guide to XMP field Type Validator and UI Element settings.

Type Validators
An XMP field's type validator setting controls what type of data is able be entered, preventing invalid
date entry.

• None: Effectively the same as String, used by legacy MediaBeacon configurations to denote a field
that had just been created.

• String: Field will allow UTF-8 characters.
• Date: Allows only ISO 8601 date format data (YYYY-MM-DD, 1984-10-20).
• Force Dictionary: Allows a dictionary to be chosen to restrict entries to the values in the dictionary.
• Suggest Dictionary: Allows a dictionary to be chosen to suggest values to be entered in the XMP

field.
• Hierarchy: This option enables hierarchical functionality for dictionary fields. This option is set

manually and the dictionary that is configured with the dictionary field must be formatted as a
hierarchical dictionary.

• EMail: Validates the string entered has a single "@" character with at least 1 letter on preceding and
following it.

• Phone: Allows digit characters and "-" or "." characters.
• Integer: Allows a positive or negative integer value. The value must be between -2147483647 and

2147483647. Only digits and the minus sign ("-") may be entered. This is a 32-bit signed integer.
• Positive Integer: Allows a positive or negative integer value. The value must be between 0 and

2147483647. Only digits may be entered.
• Real Number: Allows entry of a decimal number.
• Positive Real Number: Allows entry of a positive decimal number.
• Large Number: Allows a positive integer from 0 to 9223372036854775807 (2^63). This is a 64-bit

signed integer.
• Asset Reference: Validates that an entered string matches a currently extant asset's Asset ID /

Record ID. Makes a field CSV even if set to String in UI element. A field with this type validator must
have the "Index SQL" option enabled to operate correctly.

• Data Block: See the Data Block section, below.

Data Blocks

Data Block fields (aka Repeating Data Block fields) are a data structure that allow a set of fields to be
added in a repeating fashion. This is similar in function to multivalue fields, but include several field
values for each repeating instance.

The data block uses another Form as a "template" of fields to repeat, using the settings inherent to
that Form. This is assigned in the "Data Block" property field in the Edit Field dialog, similar to setting
a dictionary for a Force or Suggest Dictionary field.
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This Form is the element that will be repeated for the Data Block field.
 

 

The Field configuration for the data block field.
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A Form containing a Repeating Data Block.

Data Block Data Structure & Search Filtering

The values written by a Data Block are not copied to the fields that compose the Form used for the
"Data Block" property field setting, instead being written as a strided value.
 

 

This data is displayed by the Search Filter as though the values were written to the fields in that
"template" Form.
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Data Block Configuration

• Using the "Data Block" Type Validator, the UI Element is automatically set to "Repeating Data
Block" and the Synchronization Strategy is automatically set to "Synchronous".

Using Data Blocks

• Data block fields are not displayed directly in Search Filter components. Instead, the Search
Filter considers the data to be written to the "source" fields.
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• When a data block field values are written, all other field values entered using that Form are
written Synchronously.

UI Elements
A field's UI element setting controls how it's displayed in a Form. However, some UI element settings
directly control data entered or underlying data structure.

• String: No special UI, basic data. Displays a single line of text, prevents line-breaking characters
from being entered via keyboard.

• Textarea: Displays an expandable text-entry XMP field element. Entered line-breaking characters
are displayed as breaking strings.

• Cascade: Displays hierarchical dictionary XMP fields as a cascade element.
• Comma Separated Cascade: Displays multivalue hierarchical dictionary XMP fields as a cascade

element.
• Date: Displays a date picker on the right side of the field element.
• Checkbox: Displays the field element as a checkbox. When the element is enabled (checked), the

value of the field will be the string "true". When the element is disabled (unchecked) the value is null.
• Comma Separated Values: Allows the field to contain multivalue string data.
• Comma Separated Dates: Allows the field to contain multivalue date data.
• Comma Separated Textarea: Allows the field to contain multivalue string data that can contain

line-break characters.
• Repeating Data Block: This UI element is automatically selected when the Type Validator "Data

Block" is selected.
• Simple HTML: Allows entry of html text. This element uses a rich text editor.
• Advanced HTML: Allows entry of html text. This element uses a raw text editor, and a preview of

rendered HTML.
• URL: This acts as both a validator and as a UI element setting. The string entered must start with

"http". Saved values are presented as a clickable hyperlink.
• Starred Rating: Allows a starred rating to be entered.
• Code: Displays the XMP field value in a code editor.
• View Only: Prevents data entry into an XMP field when displayed on a Form. Best practice is to use

this setting only in Form configuration.
• Hidden: Prevents display of the field when included in a Form . Best practice is to use this setting

only in Form configuration, and is often paired with a value entered in the "Default" property field.

List of Valid Combinations
Type Validator / UI Element

• String / String
• String / CSV
• String / Text Area
• String / CST
• String / Checkbox
• Date / Date
• Date / CSD
• Force Dictionary / String
• Force Dictionary / CSV
• Force Dictionary Hierarchical / String
• Force Dictionary Hierarchical / CSV
• Force Dictionary Hierarchical / Cascade
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• Force Dictionary Hierarchical / CSC
• Suggest Dictionary / String
• Suggest Dictionary / CSV
• String / Advanced HTML
• String / Simple HTML
• String / URL
• Email / String
• Phone / Email
• Integer / String
• Positive Integer / String
• Real Number / String
• Positive Real Number / String
• Large Number / String
• Asset Reference / String
• Data Block / Repeating Data Block

4.4.3.  XMP and Other Metadata Standards

While MediaBeacon offers flexibility for field and Form definition, it must be stressed that XMP
nomenclature standards must still be rigorously followed.

Fields also have a large array of possible settings, some of which have implications for downstream
data re-use, data design and governance, user experience, or other substantive things.

For these reasons, sections below will list Background and Best Practices for important points.

4.4.4.  Predefined XMP Fields

Note:  It is highly recommended to leave as is the settings of predefined fields in MediaBeacon. These
may have an internal function that require specific settings to operate.

4.5.  Forms Workspace

How to Configure Forms in MediaBeacon?

A Form is MediaBeacon's primary way to display metadata. Many predefined Forms are built-in but
many will be created by administrators for specific customer use cases. Once XMP fields have been
defined in the "Fields" tab, Forms are built using a list of XMP fields, each displayed with separately
configurable properties in spindown tabs. The XMP fields that a Form uses may be from multiple
schema, and may also display or operate differently than their "base" configuration.

1. Manage > System

While Creating forms using the “Create from Schema” option, in order to eliminate redundancy,
choose a base name before the Create from Schema option.
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2. Create -> Create from Schema -> Select Base Schema

 

 

Note:

Choose unique names to avoid confusion.

• Create Form: Displays the Create New Form dialog, creating a new Form when all required property
fields have been filled.

• Create From Schema: New in MediaBeacon 2019.x, this command allows all current fields that
share a schema to be automatically added to a new Form.

4.5.1.  Form Configuration Asset Metadata

Name
The name of the Form. Primarily seen in the Asset View and the Bulk Edit dialog, for end users, but is
referenced by the Admin Core in several places, primarily, the Visible Forms field in ACL configuration.
When a Form's name is changed, it will need to be reassigned to:

• ACL "Upload Form" field.
• ACL "Visible Form" field.
• Workspace Config: "Default Asset View Form" field.
• Workspace Config: "Default Asset View Tabs" field.
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• Workspace Config: "Required Forms for Upload" field.
• Upload HTML component configuration dialog: "Required Forms for Upload" field.
• Form component configuration dialog: "Select a Form" field.
• Infinite Scroll View component: "Forms Required for Upload Linking" field.
• Tile View component configuration dialog: "Forms Required for Upload Linking" field.
• List View component configuration dialog: "Forms Required for Upload Linking" field.
• Video Edit component configuration dialog: "Forms Required for Upload Linking" field.
• Form Stamper component configuration dialog: A stamp that uses fields in a renamed Form will

need to be deleted and recreated if edits to that field need to be made.

Class
• This CSS class name is applied to the HTML element containing the Form. Note the Form tab itself

is not classed via this setting.

Enable Grid View
• When enabled, the Form is displayed in grid view.

• Requires that only "Comma Separated" fields be used in the Form configuration.
• Requires that each of the values contain the same number of entries in each multi value field.
• When an Form is in this view, values cannot be edited.
• This type of metadata governance is not encouraged as a database rebuild could change the

order of the values. Best practice is to use data block functionality.

Fields Section
This area displays "Form fields" as rows of spin-down panels. These may be an included XMP field or a
"static" row, containing only text. Each of these rows contain a number of property fields to define the
Form field. Click the "Add" button to add a Form field section.

Field Name
• This field allows the user to choose the XMP field used for the current Form field. XMP fields are

listed by Display Name, Schema, and Internal Name.

Display Name
• The name of the XMP field as it will be displayed within the current Form.

Static
When enabled, this option changes the field row to display as a static line of text.

• Display Name: Text entered here is displayed as line of text instead of a XMP field.

• Static: This option toggles off the static mode.

• HTML: When enabled, this option displays the value in "Display Name" as rendered HTML.

• Order: Operates as described below.

Not Empty
When enabled, this option makes the field "required". When used in a Form, a required field prevents all
XMP fields on that Form from being written until the required field is filled.
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Field UI Options
See the Field Type and UI Settings on page 48 article for a list of these settings.

• Type Validator: See the Field Type and UI Settings on page 48 article for a list of these settings.
• Default Value: A string entered here will be automatically pre-populated into the Form field when

viewed.

Order
This property field accepts integer values that determine the ordering of Form fields on a Form.

• These values do not reorder Forms fields in the Edit Form dialog, only when a Form is displayed in
the Web UI.

• Form fields do not inherit the "Order" value from XMP field properties, being null when added. Form
fields, therefore, will display in the order they were added unless this value is set.

• Form fields with a null Order value are assumed to have a order value that matches their "initial
order", that is, or the position corresponding to the order in which Form fields were added in the
Edit Form dialog. For example, the fourth added Form field is automatically ordered as the fourth
field in the Form when viewed in the Web UI.

• If a Form field is given an order value that matches a null field's initial position, the null value field
will be ordered before the non-null field.

• Fields that have the same Order value (null or specified) will be ordered in the order they were added
to the Form.

• Best practice is to number fields with large values (100, 200, 300, etc, so that rearranging Form
fields in the future can be done easily.

Edit Form dialog fields Form View

Field A (Order: null) Field A

Field B (Order: 4) Field D

Field C (Order: 4) Field B

Field D (Order: null) Field C

Javascript
Forms can execute client-side JavaScript based on different events, which can be used to build
panels that update dynamically based on user activity. These events can trigger for an entire panel or
individually by field.

• On Show: Triggers upon the Form field being called to be displayed.
• On Focus: Triggers when the field becomes the focus of user input, usually by tabbing or mousing to

the field.
• On Blur: Triggers when the field loses input focus.
• On Change: Triggers when a field's value changes.

Column Count
The value entered here determines the number of columns used to display Form fields in the Web UI.

4.5.2.  Changing Type Validator and UI Element Settings with Forms

Changing Type Validator and UI Element Settings with Forms.
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Forms allow abstraction of an XMP field's parameters, to alter the function of that field as displayed in
that Form. Below are some well-known combinations.

• Upload Form Auto Metadata: Using this combination will enforce automatic metadata entry
without the user's interaction or knowledge on an upload Form. Using this method, a specific
metadata value will be entered whenever an upload is made with that Form.

• XMP Field: Any Type/UI combo
• Form field settings: Use UI element "Hidden", and enter a value in the "Default" parameter field.

The entry must be valid for the type of field. For example, a valid dictionary value if the field is a
Force Dictionary field.

• Subset Dictionaries per Business Unit: These techniques can be useful if a different sets of users
need to enter exclusive sets of values (dictionaries) in a single XMP field. An example of this might
be a "Flavor" field. The first of the two business groups that use the field makes baby food and the
second makes pet food. Thus, the dictionaries used by each group need to be different. To avoid
having to create business-specific fields, we can use one of the techniques below.

• Master Dictionary & Subsets: In this scenario, the XMP field in question will be a Force
Dictionary field, with a "master" dictionary attached. When this field is used on a business-
group specific Form, it will be paired with a business-specific "subset dictionary". The master
dictionary must contain at least all terms contained in all subset dictionaries, to avoid write
errors.

• Subsets Only: In this scenario, a non-dictionary XMP field would be used (Type Validator: String).
The Forms themselves ensure no business group user will enter an inappropriate term within
their individual context. The major advantage here is that this eliminates the need to maintain
a set of master/subset dictionaries. Metadata administrators may find the Search Filter's drag-
and-drop tagging feature useful for metadata editing in this case.

• Auto Updating Suggest Dictionary & Subsets: This scenario uses several configuration points
in conjunction.

• Create a "Master" Dictionary, and connect it to a Suggest Dictionary XMP field.
• Enable the "Synchronize Dictionary to Field" option on that master dictionary.
• Create subset dictionaries as normal, however, there is no need to add all terms into the

master dictionary.
• Add the XMP field to Forms, but change Type Validator to Force Dictionary, and use a subset

dictionaries as needed.
• This method will cause the master dictionary to auto-populate with terms as they become

tagged into assets.

• View-Only Fields: While simple to set up, this technique makes it easy to control who can enter
metadata and when on specific fields.

• The UI element "View Only" isn't recommended for use with XMP field configuration, only Form
field configuration. This would create an uneditable field in the former case.

• Do not use "View Only" in conjunction with the "Not Empty" option. This will cause the Form to
prevent any edits to all displayed fields.
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• On an upload Form, a View Only field can be used with the "Default" value to show users values
that are being auto-added.

4.5.3.  Create Custom Forms

This feature is a refinement of MediaBeacon’s JavaScript framework in Forms, making
many#commonly-requested#dynamic field configurations easy to implement with no JavaScript
coding.

The Edit Form dialog now has a new section for Custom Form Rules. It will only be shown when a Form
that has existing fields is opened for editing.
 

 

• Clicking the “Add” button below “Custom Form Rule” will add a new rule.
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Feature Specialities of Custom Form Rules

• The behavior of "On Change" rules running on load was added.
• The option to “Apply rule to "On Load" action” was added.
• “Trigger Field” renamed to “Source Field”
• “Action” is relabeled “Target Field”
• Trigger pulldown no longer contains “On Load”, that option becoming a separate checkbox.

Custom Form Rules Interface

Source Field
This subsection defines what field values must be present for a custom rule to be activated. The
interface is the same as that used for Advanced Search criteria with the exception that the “Select
Field” pulldown will only show the fields that are currently defined in the Form’s “Fields” area.

Target Field
This subsection has two main options, Standard Action and Advanced Action.
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• Standard Action: This interface allows the user to designate one or more#currently-defined#Form
fields (and a condition for each) to be activated then the source field criteria are true. Below is a list
of Standard Action Conditions and condition values.

• Append Value(enter a string): This action adds the designated string to the existing value of the
target field.

• Replace Value#(enter a string or null value): This action replaces the existing value of the target
field with the designated string. A null value will erase values in the target field.

• Add Static Text#(enter a string or a null value): The string here will be displayed as informational
text below the target field.

• Set Visible#(choose “true”, “false”, or “match filter”): If true, the target field will be visible. If false,
it is hidden.

• Set Invalid#(choose “true”, “false”, or “match filter”): If true, the target field will be marked as
invalid and prevent saving the Form. If false, it is normally writeable.

• Set Not Empty#(choose “true”, “false”, or “match filter”): If true, the target field must not be null
to allow saving the form. If false, the field may be left empty.# Note that the “Required” label is not
shown when this condition is in the true state.

• Set Enabled#(choose “true”, “false”, or “match filter”): If true, the target field may be written to. If
false, it will be non-editable.

• “Match Filter”: This option for all the “Set” conditions above allows the true/false status of
the source field to activate/deactivate that given condition. In practice, it means that these
conditions will not need to have two rules to define a toggleable condition, such as hiding /
showing a field when it contains only a specific value

• Advanced Action: This allows client-side JavaScript to be entered as the action to perform upon
the source field criteria being true.

Trigger Event
The “Trigger Event” pull-down sets the event that triggers the Rules be executed on a form.

• On Change: When a user changes field values while using a Form containing a custom rule. This is
the most used trigger type.

• On Submit: This trigger type only shows a target field, and as such is most useful for “Append Value”
or “Replace Value” actions. These actions only occur when the Form is saved.

• On Post Save: This trigger only allows Advanced Actions to be executed, occurring after other
metadata writes have concluded.

• On Load: Triggers when the Form as a whole is loaded.
• On Submit: Triggers when the Form as a whole has been submitted to write changed values.
• On Post Save: Triggers when the values the Form submitted have been written.

Other Trigger Event Options
• Implicit On-Load behavior: This feature will automatically execute the “On Change” trigger once

when loading the form, in order to use on change events to set an initial state, especially of “Set”
conditions.

• Apply rule to "On Load" action only (skip "On Change"): This option, when checked, changes a “On
Change” triggered rule to only occur when the Form is opened.
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Overridden Set Conditions
“Set” conditions replicate some field#settings, but#are#superceded#by field property settings. If a
field has the following:

• UI Element set to “Hidden”, the “Set Visible” condition cannot make the field visible.

• An invalid value is entered in a field for the given Type Validator, the “Set Invalid” condition cannot
not make it a valid value.

• “Not Empty” checkbox checked, the “Set Not Empty” condition cannot make the field non-required.

• UI Element set to “View Only”, the “Set Enabled” condition cannot make the field writeable.

The best practice when toggleable field states are required is to avoid configuring the base field
configuration (or the fields’ Form properties) to the restrictive property options, and instead use
Custom Form Rule logic to enforce those properties.

4.5.4.  List of Preconfigured Forms

Forms predefined in MediaBeacon.

Industry Standard
• Adobe PDF
• Adobe PDF Properties
• Adobe Photoshop
• Adobe Photoshop Properties
• Adobe Stock Photos
• Camera Data 1
• Camera Data 2
• Dublin Core
• Dublin Core Properties
• EXIF Properties*
• EXIF Properties Additional
• IPTC Contact
• IPTC Content
• IPTC Properties
• IPTC Status
• QuickTime Metadata*
• TIFF Properties
• Rights Management
• Rights Management Properties
• Stock Photo Properties
• Stock Photo Resolutions
• XMP Basic
• XMP Core Properties*
• XMP Media Management Properties

MediaBeacon Defaults
• Approval
• Archive
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• Brand Hierarchy
• Campaign Information
• Download Approval
• Facebook Post
• Marketing Fields
• MediaBeacon Default

• MediaBeacon Link

• MediaBeacon MetaData

• MobileApprovalDisplayFields

• Permissions
• Post to Social Media
• R3volution Workflow
• Regions
• Restriction on Download
• Social Media
• Social Media Schedule
• Task Initiation
• Twitter Post
• YouTube Upload

Special Forms
These Forms do not display data as standard

• Advanced XMP: Displays all XMP metadata in an asset, and allows the user to delete an schema of
metadata at once. Only Global Administrators have access to this. And they always do regardless of
ACL setting.

• Asset Links: Displays MediaBeacon Links.

• Automatic Versions

• Brightcove Cue Points
• Document Report
• Managed Versions
• Used in Assets
• Video Clips
• Video Summary
• Video Transcodes

4.6.  Loading Dock Types Workspace

A Loading Dock Type categorizes and defines preset conversions, as well as defining the allowed
parameters of custom conversions.

Conversions are download-only files prepared from an existing asset when a user needs a “rendition”
of an asset in another format. Conversions are not saved as assets in the system, rather they are
generated internally and sent to a back-end holding directory (the “Loading Dock”) and are retained
for up to 7 days, and then automatically removed. Conversions contain all the metadata of the original
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asset, but notably, if metadata were to change on an asset before a conversion were downloaded, it
would only reflect the metadata present in the original asset at the time of conversion.

Figure 6: Advanced, Basic, Print and Web are examples of Conversion Preset tabs

Figure 7: Example of Custom Conversion tab
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Loading Dock Types are associated with Groups via the “Loading Dock Types” field in a Group’s
properties.

Note:  The size limit of the Loading Dock is 100GB per system. Please see the [Loading Dock Conversion
Retention] article for more information

4.6.1.  Creating Loading Dock Types

1. While in the Admin Core, go to the Loading Dock workspace: Navigate > Loading Dock Types.
2. Select Create > Loading Dock Type

 

 
3. The Loading Dock Type dialog is displayed. Once settings are made, click the “Create” button.
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4. The new Loading Dock Type will now be an option in the Group Edit and/or Create Group dialogs

as a pull-down for the Loading Dock Type property. The Loading Dock Type chosen for a Group will
configure what options all users in all ACLs of a group have for downloads.

Note:  Setting changes to a loading dock will be available to users, immediately after the loading dock
type has been saved

Depending upon configuration, a Loading Dock will affect settings presented in the:

1. Conversions Dialog Preset tabs
2. Conversions Dialog Custom Conversion tab options
3. Conversion Component Options dialog, which based upon component setting, may appear as a

drop-down in the Asset Menu
4. Visual Workflow’s Convert Asset Node properties

4.6.2.  Loading Dock Type Configuration

The properties of a Loading Dock type are broken down into sections; some of which are used
in Conversion Preset tabs, and some are used as pull-down selections in the Custom tab of the
Conversions Dialog.
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• Platform Properties: Custom Tab
• Image Formats Properties: Custom Tab
• Rotate Properties: Custom Tab
• Scale Properties: Custom Tab
• Resolution Properties: Custom Tab
• Intent Properties: Custom Tab
• Source Colorspace Properties: Custom Tab
• Destination Colorspace Properties: Custom Tab
• Conversions Properties: Preset Conversions Tabs
• Video Formats Properties: Preset Conversions Tabs
• Script Options Properties: Preset Conversions Tabs

Each of these sections has a “Show <name of section>” checkbox at the top, which toggles visibility of
that section in the Conversions Dialog’s UI, as well as any place another component would make use of
Preset Conversions in its configuration.
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Property Section: Custom Tab Section
The below sections are similar in configuration; each section may have any numbers of “blocks”, each
one defining the Label and Function of a selection that would appear in a pull-down menu of that
section when shown in the Custom Tab.

Figure 8: An example new property block. It has a generic title until it is saved.

• Platform: Defines whether the converted file will be formatted for use with;

• mac (macOS)
• pc (Windows)
• auto (The system automatically determines the platform of the downloading user)

Note:  This property is practically irrelevant for modern platforms. This functionality was used
for very old implementations of some formats (such as TIFF) that historically had differences in
the file structure depending upon on OS platform. In these enlightened days, of course, no one
believes a word of it.

• Image Formats: The full list of image formats is provided in the appendix of this article. Some
formats are listed here as well due to their special implications of use. For the future some kind of
reference on Asset transparency is needed. reference to appendix

• EPS (Encapsulated PostScript)

• Converting a raster image asset into an EPS format will not generate vector art or selectable
text, the image will simply be placed in the EPS as a raster object.

• nochange

• This property will simply download a copy of the asset, no changes made.

• PDF

• Converting a raster image asset into a PDF format will not generate vector art, or selectable
text or embed or use fonts from an orginal asset, the image will simply be placed in the PDF
as a raster object.

• Multi-page PDFs are not generated by the system. For example, a four page .indd document
will be converted to a PDF that is a raster representation of the first page of that document.

• PNG
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• This format is somewhat problematic in that per Adobe’s standards, PNG images should
never have XMP blocks. For this reason, metadata is stripped out of converted PNG files.

• PSD (Adobe Photoshop)

• Converting into this format does not retain or generate layers, nor add anykind of enhanced
editability over a flat-raster format.

• Rotate: Allows a value form 0-360 to define the rotation of the conversion. Using this in 90°
increments it typical, but if an odd angle is used, the converted image will use a white background
behind the rotated image.

• Scale: Allows scaling settings to be added to a conversion. The Unit designated for this property
allows an image to be scaled by a static percentage, within a predefined maximum height and
width.

• Note:  When scaling an image with a conversion it is worth noting that the image will be
resampled.

Note:  Scaling will always retain assets’ aspect ratio. If a 100 x 200 image is converted using a
300 x 300 scaling, the resulting image would be 150 x 300.

• “Show Custom Scale” checkbox: This allows the user to designate a scaling using either
Percentage or pixels.

• Resolution Properties: This property will scale images based upon the image’s built-in resolution
setting. For example: if a 100 x 100 image at 72 dpi were downloaded as 300dpi conversion, it would
be resampled to 416px x 416px.

• Intent: This property, when set, will enable more advanced color conversion options. This is most
often used when converting an image in a known color space to another known colorspace, for
example RGB to CMYK. For more information on the individual setting’s effects, please see https://
en.wikipedia.org/wiki/Color_management#Rendering_intent.

• Source / Destination Colorspace: Allows the Source and Destination colorspace to be defined as
RGB, CMYK, or GRAY.

• Source / Destination Color Profile: If the Source or Destination Colorspace is defined, an ICC profile
may be designated for that respective property. The list of ICC profiles is internally defined.

Property Section: Preset Tab Section
• Conversions: This section controls “configuration presets” that will be presented throughout the

system.
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• Each repeating block represents a preset suite of conversion settings.

• Name: The name of a preset.
• Icon: The standard icon picker is used to define the icon used for the preset.
• Description: The text here will be shown under the Name, providing explanation to the user.
• Category: This field may contain any value, not just the predefined category labels that are

show in the pull-down. Values here generate one or more conversion tabs that the labeled
conversions will be organized within.

• Download on Conversion Complete: This property allows conversion preset downloads to
immediately download once the conversion processing has completed. If this is not set, the
user will need to initiate a download of converted assets from the Notifications (Bell) Menu.

• Note:  It should be considered standard to enable this property for all conversion presets,
as it provides a more-responsive download experience for users.

• Lock: Deprecated, has no function.
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• Conversion Settings: This set of properties in the conversion block are analogous in function
to those the Custom Tabs section, but for only one conversion preset. Please refer to those
sections for a discussion of the function of these properties.

• Note:  Some property fields control the visibility of other fields in this form, hiding them
until a value is chosen. Platform, Format, Source Colorspace, Destination Colorspace all
operate in this manner

• Video Formats: This type of conversion is only presented when the user’s download selection
contains only video assets. If a selection contains still and video assets (which have no conversions
in common) the Conversion dialog is not displayed and the originals of these assets are
downloaded.
 

 
 

 

• Name: String used for the Video Conversion’s name.
• Allow Edits
• Video Format: The format used for the conversion. This list is defined by the “Movie Profiles”

present in the system, defined in the MediaBeacon Server GUI App control panel.
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• Category: This functions in the same manner as the Category property in the Conversions
section, see above.

• Note:  Best Practice Suggestion: Because a video conversion is a more server intensive
operation in terms of processing, and the fact that conversions are only kept for a limited time.
The use of video conversions can create unnecessary load on a system. It may be preferable to
rely upon “Prepared Movie Profiles”. That is, Movie Profiles that are set to automatically generate
when a video asset is uploaded. These then function as pre-rendered conversions and are
accessible via the “Video Transcode” Form

• Script Options: This section allows configuration of preset conversions that are customized. These
types of conversions usually call a .BAT script on the server to leverage custom settings for use
with MediaBeacon’s conversion libraries, or a or a Photoshop Droplet .EXE to perform a conversion.
 

 

• Preset Properties

• Name: Preset’s Name
• Description: Preset’s Description
• Image Key: This defines the icon of the conversion. This feature does not use the Icon Picker

directly to define its icon, but uses the UUID of an icon that’s been loaded into the Icon
Picker. See the “Global Icon Key” section for more on how to extract this UUID.

• Script Path: This is the explicit filepath on the server to the script file. Scripts and droplets
must be added to the “\m-userinfo\m-utscripts\” folder within MediaBeacon. The server
must then be restarted.

C:\Users\Administrator\MBAssets\m-userinfo\m-utscripts\Script Options Example.bat

• Edit Original

• Format: This defines what format an asset must be to have this Script Option as an available
Conversion Preset. The value here should match the string of the corresponding image
format. Refer Loading Dock Appendix.

• Output Format: This defines the format of the output. Similar to the above property, the
value here should match the string of the corresponding image format, and match what
format the script outputs.
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Best Practices Suggestion
If the users of an ACL do not require use of Custom Conversions, it is good practice to include the
“Custom Conversions” Permission Restriction in that ACL. This inclusion will suppress the display of
the Custom tab in the Conversions dialog, thereby making these properties irrelevant to configure.

4.6.3.  Loading Dock Conversion Retention

Note:  The “Loading Dock Quota” property is not present in MediaBeacon 20.2 and later

Conversions (download-only files retained in the Loading Dock cache) are kept by MediaBeacon:

• for up to 7 days, or
• until their conversion notification is deleted, or
• the MediaBeacon instance’s conversion Loading Dock cache becomes filled (default maximum of

100GB).

When the Loading Dock cache’s limit is exceeded (the total disk space taken up by all conversions), the
oldest conversions will be deleted automatically as needed.

This limit may be adjusted by a system property: mb.ld.cache.size.gb, the default value being 100 (value
designates number of Gigabytes).

4.6.4.  Loading Dock Appendix

List of Image formats:

1. AVS
2. BMP
3. CMYK
4. DCX
5. EPS
6. FAX
7. FITS
8. GIF
9. GRAY
10. JNG
11. JP2
12. JPEG
13. MIFF
14. MNG
15. MONO
16. MTV
17. nochange
18. OTB
19. P7
20.PCD
21. PCX
22.PDB
23.PDF
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24.PICON
25.PICT
26.PNG
27. PNM
28.PSD
29.RGB
30.RGBA
31. SGI
32.SUN
33.TGA
34.UYVY
35.VICAR
36.VIFF
37. WBMP
38.YUV

For more information on file formats, please see the “Supported Image Formats” Section of
ImageMajick documentation. Please note that not all the formats supported by this tool are
implemented or even implementable in MediaBeacon.
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5.  Web UI Configuration
This section covers administrator-level configuration options for workspaces and components.

5.1.  Workspace Configuration

MediaBeacon’s workspaces and components can be configured by Global Administrators in three
ways, Admin Mode, Admin-Only menu commands, and Option & Configuration dialogs. The first two
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are discussed below, while dialogs are covered in context throughout Workspace Configuration
subsections.

5.1.1.  Admin Mode

Figure 9: Normal View

Figure 10: Admin Mode

A key concept in MediaBeacon configuration is "admin mode". In this state, the UI is displayed with
additional elements allowing access to a variety of different configuration interfaces.
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Admin mode is enabled by either a contextual menu command, or a keyboard shortcut:

• Selecting the "Admin Mode" command in the workspace contextual menu.
• macOS: Command-Shift-A
• Windows: Control-Shift-A

While in Admin mode, the UI displays several configuration elements:
 

 

• Workspace Tabs (blue)
• Layout Zones (purple)
• Components (pink)
• View component filter header configuration
• Form Stamp component configuration
• Gear Icons, indicating

• Workspace Tab Menus
• Layout Zone Configuration Panels
• Component Configuration Panels

5.1.2.  Manage Workspace Dialog

Options for workspace configuration in the Manage Workspace dialog.
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The Manage Workspace dialog controls workspace behavior in most respects.

A visual indicator has been added to the Manage Workspace dialog to indicate when a workspace is
shared with one or more other ACLs.
 

 

Dialog Sections

General
• "Back" button (left arrow in the dialog's upper left): Cancels changes to workspace configuration.

• "Done" button: Applies changes to configuration.
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• Note: Adding workspaces in the component sections are added or removed immediately,
regardless of clicking "Done".

• "Search Components" field (in the upper right of the dialog): Text entered here will filter the
components displayed in the components sections, see below.

Component Sections
Four spin-down sections are listed here, each a different class of component:

• Search Components
• Information Components
• Action Components
• View Components

Components can be added to the workspace in these sections, and the "Search Components" field will
filter components based upon their name.

Note that some components can have multiple instances present on a workspace, and others cannot.
When a component is added to the workspace via the "Add" button, this is indicated as shown below.

 

 

• Single-instance components: The "Add" button becomes a "Remove" button,
• Multi-instance components will show a "number of instances" indicator (xNumber) to the left of the

"Add" button.

• Note that to remove multi-instance components, this must be done outside of the Manage
Workspace dialog, by clicking the "X" button on the component's title bar while in admin mode.

Layout & Theme
The Layout section allows the user to choose between different arrangements of layout zones for the
workspace. The "Default header footer" is the most flexible of these and is the most commonly used.

• Recommended Layout: Default Header footer

• Other Layouts: Default, Default header widget, Single column, Single column view, Three by two,
Two column, Two column header footer, Vertical columns

Note that when a layout is changed, the components may be rearranged.
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Themes
This area has been substantially simplified in MediaBeacon 2018.0 and greater, now showing a single
toggle control to use the Dark Theme.

 

 
 

 

Workspace Options

Styling Options
• Hide Menu Bar:Hides the menu bar on the workspace. This option is disabled by default.

• Hide Workspace Tabs:Hides the workspace tabs. This option is enabled by default.

• Theme Color:This changes the "primary" color of the workspace: button color, toggle color, folder
and asset selection color, etc.
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• Menu Bar Background Color:This color selector allows the admin to choose a different background
color for the menu bar. Note that the text will automatically change to a contrasting grey scale
color, and that the pulldown menus themselves remain as the theme color dictates.
 

 

• Home Button Icon:An icon may be chosen here, using the standard icon picker. The home button
displays at 140x38px, and the icon will scale to fit within that area.
 

 

• Workspace Icon:An icon chosen here will be displayed next to the name of the workspace in the
Navigate Menu and the workspace tab.
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• Custom CSS Classes: Strings entered here become CSS classes on the body tag of the current
workspace.

• Browser's Window Title: A string entered here becomes the browser tab label.
 

 

• Home Destination Workspace: Specifies the workspace the Home button should take the user to.
The user can choose the Home Destination Workspace from the drop-down list.

URL Options

Note:  These options are not commonly used in most installations of MediaBeacon.

• Custom URL for Workspace: A string entered here acts as a redirect to the given workspace,
for example: "https://externaltraining2.mediabeacon.com/p/example" might resolve to "https://
externaltraining2.mediabeacon.com/gwtmain/GwtMain.html#!MP;;p=464EBF9D-94E5-419B-
A741-7EC76D9A2EE9;;par=0=1=50". The custom URL does not function as a "vanity URL", the
workspace's URL remains the same. Note that users who follow such a link cannot be shown
workspaces to which their ACL's do not have access.

• Custom Login URL: A URL entered here will cause MediaBeacon to redirect the user to that URL
with the user accesses MediaBeacon in a non-logged in state. This can be after logging out, but also
connecting to MediaBeacon while not logged in. This behavior is dependant upon what workspace
the user last used, which is stored in a browser cookie.

• Custom Link URL for Emails: A partial URL entered here can redefine the URL sent via email
mechanisms in the system. This can be useful if your MediaBeacon instance has a different external
DNS assignment then internal to your network.

Default Behavior Options
• Zip Quick Downloads: Enabled by default, this option sets the default behavior for Quick

Downloads. When disabled, quick downloaded assets will be automatically decompressed, no ZIP
file being left behind. Note: this behavior only pertains to the Quick Download function, not the
Download function.

• Set Default Download File Name: When multiple assets are downloaded at once, they are combined
into one ZIP file with the name "MediaBeaconFiles.zip". A string entered here changes this name for
downloads from the workspace being configured.
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• Default Asset View Form: A single Form may be designated as the default Form which will be
expanded when the user opens the asset view. This Form can not be removed from the asset view,
and will always be displayed when browsing to a new asset from within the asset view (using the
next and previous buttons). Note: Although a global administrator may choose any Form for this
field, the ACL's "Visible Forms" entries have precedence. The upshot being that if the Default Asset
View Form is not in the ACL's Visible Forms list, it will not be displayed.

• Default Asset View Tabs: Multiple Forms may be designated as "default tabs". These Forms tabs will
always be listed in the metadata panel of the asset view, and cannot be removed. Note: Although
a global administrator may choose any Forms for this field, the ACL's "Visible Forms" entries have
precedence. The upshot being that if a Default Asset View Tab is not in the ACL's Visible Forms list,
it will not be displayed.

• Required Forms for Upload: One or more Forms may be chosen for this entry, becoming the
upload Form used for all uploads in this workspace. This setting will supersede the ACL upload
Form setting, and is overridden by upload Form settings in components. Component upload
Form settings only pertain to uploads initiated by clicking or asset-dragging directly on that
given component. The upshot is that the Create > Menu command's upload Form behavior can be
controlled only with the ACL or workspace "Upload Form" setting. Of special note: Forms chosen
here are NOT restricted by the ACL's "Upload Form" setting; therefore a workspace can use an
upload Form that is not otherwise visible to the user in asset view.

• Fields On Asset View General Tab: Fields chosen here are displayed at the bottom of the "General"
tab in the asset view. At least one must be specified. Any field may be chosen, and is not limited to
fields that the ACL has in any "Visible Form". Note: Adding a field here will make that field editable
by the user, unless the user's Group "Edit Level" setting is lower that the given field.

• Fields below Asset Link: Fields chosen here will be visible in the asset preview pane of the "Asset
Links" Form tab. Note: Adding a field here will make that field editable by the user, unless the user's
Group "Edit Level" setting is lower that the given field.
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Advanced JavaScript Options
The following areas allow JavaScript code (using MediaBeaconJavaScript API) to replace the function
of certain actions in the interface.

Note that if these sections are turned off via the right-hand toggle button, the contents will be deleted.

• Enable javascript on direct download: Code entered here replaces the function of all download
actions on a workspace, except those in the Notification Center.
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• Enable javascript in the asset view: Code entered here replaces the function of opening the asset
view.

• Enable javascript on home button click: Code entered here replaces the function of the home
button. This is sometimes used to change this interface element to navigate to a specific
workspace, rather than clearing search criteria.

• Notification Center Options: Enable javascript on direct download: Replaces the function of
download actions in the Notification Center. Note that this includes conversion downloads that use
the "Download on conversion complete" option in their Loading Dock conversion preset.

5.1.3.  Using Workspaces

How to add, arrange and share workspaces.

This article deals with workspaces as arranged within ACLs. For "Manage Workspace" functionality, see
Manage Workspace Dialog on page 76.

Workspaces Overview
Each ACL can contain a number of workspaces, each of which has a UUID that is displayed as part of
the browser's URL. This UUID is always specifically tied to a given workspace. Identically configured
workspaces will still be unique.

Workspaces can be shared between ACLs. A shared workspace contains the same components and
settings wherever it appears. A change made to a workspace in one ACL will change it in all ACLs with
which is it shared.

Workspace Options Contextual Menu
Administrator-Level users may use several commands in the Workspace contextual menu. It may be
displayed in either of two ways:
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Contextual Menu
1. Right-click any non-component, non-menu, or non-menu area
2. Note: this method does not require the user be in admin mode.

Selected Workspace Tab Gear Menu
1. Enter admin mode
2. Select the desired workspace tab
3. Left-click the gear icon in the highlighted workspace tab.

Non-Selected Workspace Tab Gear Menu

1. Enter admin mode
2. Left-click the gear icon in a non-highlighted workspace tab.

It contains the commands:

• Manage Workspace (absent in Non-Selected Workspace Tab Gear Menu)
• Share Workspace
• Duplicate Workspace (absent in Non-Selected Workspace Tab Gear Menu)
• Delete Workspace
• Hide Workspace
• Admin Mode
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Adding Workspaces
Workspaces may be added by using the Menu Bar > Create > Workspace command, which opens the
"Add A Workspace" dialog.
 

 
The workspaces available here, except for the "Blank" option, are templates. The templates contain a
set of components that are automatically shared between each added instance of that template.

Note:  Using a template (other than "Blank") in the "Add a Workspace" dialog is analogous to duplicating
a workspace using the "Duplicate as an asset, retaining component links" option. For this reason it
is recommended to create new workspaces with only the "Blank" option, then adding and/or sharing
components as necessary is recommended.

Each workspace added to an ACL is displayed in the Navigation Menu.
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Sharing Workspaces and Duplicating Workspaces
Workspaces may be shared and duplicated.

• Sharing a workspace does not make additional workspaces, but rather gives another ACL access to
the shared workspace.

• Duplicated workspaces are new workspaces that have the same settings as the original workspace
at the time of the duplication.

Sharing
Workspaces may be shared in the "Share Workspace" dialog. To open this dialog, choose "Share
Workspace" in the Workspace Options Menu.
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1. Choose: "Share workspace to another group" Selecting this option allows the admin to choose a
group.
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2. A list of ACLs is shown for the chosen group.
3. If the group has only one ACL, as is common, it will automatically be selected.
4. Once an ACL is selected, the admin may click "Share", and the workspace will be accessible to the

specified ACL.
5. INFO CALLOUT: When a workspace is shared with an ACL with currently logged in users. The shared

workspace will not be accessible to them until they logout and log in again.

The "Download workspace as an asset" option is discussed below.

Duplicating
Duplicating a workspace always assigns a new UUID to the duplicate, and may be done in 3 ways:

• Duplicate in the current ACL, retaining component links

• Usage: Often used for creating duplicate workspaces that might have a handful of different
components between them.

• Duplicate as an asset, retaining component links

• Usage: Often used for making templates that will inherit the current settings of extant
components when used.

• Duplicate as an asset, not retaining component links.

• Usage: Often used for making independent, non-linked workspace templates.

The "component linking" function is discussed in detail in the Component Linking and Component ID
section. To summarize this feature: Component linking allows components with identical "Component
IDs" to share the same configuration.

Duplicate a workspace in the current ACL, retaining component links
1. Select the "Duplicate Workspace" command from the workspace contextual menu.
2. Workspace is duplicated with the same label, new UUID and linked components

Duplicate a workspace as an asset, retaining component links
This option will save the current workspaces as an asset (.xmpper file). It is first downloaded by the
admin's browser, and must be re-uploaded into MediaBeacon to be used.

To create an .xmpper asset.

1. Open the "Share Workspace" dialog.
2. Choose the "Download workspace as an asset" option.
3. Enable the "Preserve Component Links" checkbox.
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4. A name field will be shown, allowing the admin to change the name of the downloaded asset

a. Note: Spaces in the string will be replaced with "+" characters upon download.

To use a .xmpper asset.

1. Upload the .xmpper asset into MediaBeacon
2. Select the "Load Workspace" command in the.xmpper asset's contextual menu or asset menu
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3. In the "Import Workspace" dialog, confirm.
4. The workspace will be added to the current ACL. Note: The name of workspace will be taken from

the .xmpper's file name.

Duplicate a workspace as an asset, not retaining component links
To create a .xmpper with non linked components, use the instructions above but disable the "Preserve
Component Links" checkbox.
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Deleting Workspaces
This command deletes the current workspace from the current ACL. If the workspace is not shared
with another ACL, it and any unshared components are permanently deleted.

Hide Workspace
Choosing this setting has two effects, hiding the workspace in

1. Hiding the workspace in the Navigation menu.
2. Hiding the workspace from any users not in admin mode.

a. Admin-level will still have access to the workspace in admin mode.

Arrangement of Workspaces
An ACL's workspaces are shown in the Navigate menu, and as workspace tabs while in Admin Mode.
These tabs may be dragged and dropped to rearrange their order in the Navigate menu; tabs arranged
left-to-right translate to top-to-bottom.
 

 

The upper-leftmost tab position is special, being the workspace that the given ACL will view first by
default.

Workspace Names
Workspace names may be changed while in admin mode by double-clicking the name in the workspace
tab.
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This will change the name of the tab in the Navigate menu and other admin interface elements.

It is important to remember that workspace names are only labels that are specific to only the current
ACL. Each workspace has a UUID that is MediaBeacon's identifier for that workspace. If a workspace
is shared with another ACL, and its name is changed, the change will not be reflected in the other ACL.
The UUID number of the workspace, however does not change.
 

 

Note: Capitalization changes to name strings will not be saved. For example, if the workspace
"WorkSpace0" is changed to "Workspace0", that change will not be saved. If another character is added,
such as a space ("Workspace 0"), the name will be saved.

5.1.4.  Admin Only Menu Commands

These commands are always visible to Global Administrator-level users.

1. Menu Bar > Create > Workspace: Opens the "Add Workspace" dialog.
2. Menu Bar > Manage:

a. Workspace: Opens the "Manage Workspace" dialog.
b. History: Opens the "History" dialog.

a. Use of this command is granted to non-admin users when the "View Global Asset Log"
permission restriction is not set in user's current ACL.

c. Dictionaries: Opens the "Dictionary" dialog.

a. Use of this command is granted to non-admin users when the "Administer Dictionaries"
permission restriction is not set in user's current ACL.

d. External Plugins: Opens the "External Plugins" dialog.

a. Use of this command is granted to all users if the installation's License permits use of the
Connectors.

e. Workflow: Opens the "Workflow Manager" dialog.
f. R3Search: Opens the "R3Search" dialog.
g. System Status: Opens the "System Status" dialog.
h. System: Redirects the user to the "Admin Core" interface.

a. Note: This interface can be opened as a separate tab.
3. Contextual Menu and Asset Menu, when used on a .mbwidget or .xmpper asset.

a. "Load Component"
b. "Load Workspace"

5.1.5.  Metrics Component and Workspace Template
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The Metrics Component, used to display system usage data, is unique in that it will significantly alter
the function of other components. When included on a workspace, other components no longer
manipulate individual assets, but instead will display records of actions that have occurred in the
system.

For this reason, MediaBeacon has a preset Metrics Workspace template under “Create > New
Workspace”. This interface includes the Metrics component as well as the Filter Search, Facet Graph,
Quick Search and Search Status components. An HTML Component with several preset Report Buttons
are also included.

This workspace is used to filter and display the same events recorded by the “History” (Aka Global
Asset) Log. This includes events to assets but also events that have no asset associated with them,
such as Log In events.

The Metrics workspace will display the total number of actions that occurred during a particular time
frame. By default, Metrics workspace displays Metrics assets with 30 days date stamp on the View
Component.

Adding a Metrics Workspace
To add a new Metrics workspace, choose from the Menu Bar: Create > Workspace. Then, in the “Add a
Workspace” dialog, choose the Metrics workspace option.

This command creates a Metrics workspace containing the default Filter Search, Metrics View, HTML
component with Reports option, and a List View component.

Metrics Workspace Interface Overview
If a Metrics Workspace template is added to an ACL, the user with access to that ACL is logged in, the
user can access Metrics workspace via Navigate > Metrics.

Report Buttons
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The Metrics workspace’s a HTML component has several preset usages reports the user may view or
download.

• Download Report: When the user clicks on the Download Report button, the Metrics View displays
a graph showing the number of downloads occurring over the span of 30 days and the List View
component displays all the Metrics assets which were downloaded within 30 days.
 

 

• Upload Report: Displays the number of uploads occurring over the time span of 30 days along the
Metrics assets.
 

 

• Quicksearch Results: Downloads a CSV report of Quick Searches made by different users in
different ACLs and groups along with the date and time of the search.
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• Quicksearch Frequency: Downloads a CSV report of the frequency of Quick Searches made.
 

 

• Filter Reports: Downloads a CSV report of each field with its value in different ACLs and groups
along with the Datestamp.
 

 

Different values in the Quick Search report:

• Search Term
• Search Results
• ACL
• Group
• Date Performed

Different values in the Filter Search report:
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• Field
• Value
• Search Results
• ACL
• Group
• Date Performed

Metrics View Component
• Switch Graph Type: Users can toggle between the types of graphs i.e., line graph and bar graph by

clicking Switch Graph Type icon.

Figure 11: Line Graph View

Figure 12: Bar Graph View

• Field Switcher: Users can select between different facets present in the workspace’s Filter Search
using this drop-down. Selecting a value here toggles a field’s “Stack Graph” button in the Filter
Search.
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• X- Axis Values:

• The values shown here are the values present on one of the currently selected field, i.e., Action.
• Other values which are not categorized are consolidated as More. Here in this graph, further

actions other than the currently displayed are shown as More.

• Toggling Values from the graph: Click on the values along the X-axis to exclude them from the
graph,
 

 

or else shift-click them in the Filter Search. The values will be removed and will display grayed-out:
 

 

• View Specific values: Hover over the graph to see specific values:
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Filter Search on a Metrics Workspace
Users can alter the Metrics View graph and Metrics Assets displayed in the List View using the Filter
Search fields.

On a standard Metrics workspace, the Filter Search is pre-populated with the following fields:

• Action: Values in this field represent the type of action that the system recorded.
• Field: Values in this field represent the XMP field that was acted upon, if applicable.
• Username: Values in this field represent the user who performed the action, if applicable.
• Datestamp: Records each event's date/time.
• Subject: Values in this field represent an additional piece of information that pertains to a given

action. For example, "Edit" actions may have their subject be "Field" or "Asset". The "Create" action
on the other hand can have values that include "Field", "Selection", "Comment", "PDF", and more.

When a value on any of these fields (except Datestamp) is selected, that value is displayed in the
Metrics View. The graph will be a single line displaying the number of times the selected value has been
executed.
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Choosing a Datestamp value will filter the other chosen value over the specified timeframe.

For example, when “Search” under the Action field is chosen, as well as “Last 30 Days” under Datestamp,
the graph will show the frequency of that action over that time period.
 

 

As such, these results show all the searches performed by all users of the system, across all fields. This
may be further refined by choosing other values. In this case, “Field” will show types of Search, rather
than specific fields searched upon.
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• Stack Graph Button: When the user clicks on the stacked graph icon to the left of a given field in
the Filter Search, the Metrics component displays a “stacked graph”, multiple values being shown at
once on that field. Where each value is represented by an overlapping line.
 

 

MediaBeacon Metrics Fields
• ACL Name: (http://mediabeacon.com/ns/metrics/1.0/ acl_name)
• Action: (http://mediabeacon.com/ns/metrics/1.0/ action)
• API Key Username: (http://mediabeacon.com/ns/metrics/1.0/ apikey_user_name)

• Note: Not currently populated

• Asset ID: (http://mediabeacon.com/ns/metrics/1.0/ asset_id)

• Datestamp: (http://mediabeacon.com/ns/metrics/1.0/ datestamp)

• Note: Cannot be displayed as a stack graph itself, but used to limit the scope of graph data.

• Deleted: (http://mediabeacon.com/ns/metrics/1.0/ deleted)

• Elapsed Time: (http://mediabeacon.com/ns/metrics/1.0/ elapsed_time)
• Field: (http://mediabeacon.com/ns/metrics/1.0/ field)
• Group Name: (http://mediabeacon.com/ns/metrics/1.0/ group_name)
• New Value: (http://mediabeacon.com/ns/metrics/1.0/ new_value)
• Old Value: (http://mediabeacon.com/ns/metrics/1.0/ old_value)
• Path: (http://mediabeacon.com/ns/metrics/1.0/ path)
• Subject: (http://mediabeacon.com/ns/metrics/1.0/ subject)
• Username: (http://mediabeacon.com/ns/metrics/1.0/ user_name)

5.2.  Administrator Menu Commands

Administrator-only options in the Manage menu.
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5.2.1.  History Dialog

This section is under construction.

5.2.2.  Dictionaries Dialog

This section is covers different Dictionary fields and functions.

Dynamic Dictionary Fields
This feature allows a single dictionary to control#a set of interdependent fields; these fields in turn will
be able to filter and automatically#autofill other fields controlled by that dictionary.
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A Dynamic Dictionary is a new type of dictionary that is required to enable this functionality. In
contrast to a normal MediaBeacon dictionary, it has an arbitrary number of columns, each#of which
represent#(and will be linked to)#a different field.

Figure 13: Regular MediaBeacon dictionary

Figure 14: Dynamic Dictionary

When Dynamic Dictionary fields are used in the same Form, they automatically become reactive to the state of#other
fields that share that dictionary. In this example, the “ztr_Dynamic_Geography” dictionary’s columns are mapped to
four Form Fields.

 

 

When#a user uses the dictionary pulldown for a field, only unique values are shown.
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Fields are dynamic in two ways.#First, for example, when a user chooses “Canada” the values in “State”
become limited to only those provinces in Canada.
 

 
The second dynamic behavior occurs when other field values within the set of dynamic fields are
chosen enough to#narrow#values down#enough#so that there is only one#possible choice, those
values will be automatically filled. For example, if “Saskatchewan” is chosen,#the values for State Code
and Capital#are filled in, as there are no other logical choices.
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It is worth noting that specific behavior of the fields is dependent upon the disposition of the attached
Dynamic Dictionary.

Both behaviors are not explicitly “top-down” in terms of hierarchy#(as#hierarchical#dictionaries are),
being instead based upon term frequency in the dictionary. See the Dictionary Configuration section
for more#information.

Dynamic Dictionary Configuration
1. To create a Dynamic Dictionary, click the “Create new dynamic dictionary” button

 

 
2. This button opens the “Create New Dynamic Dictionary” dialog:
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Here the user can enter the Name and Description for the new dictionary, as well as#upload a
dictionary from an external file.

IMPORTANT NOTE: The format for Dynamic Dictionaries is NOT in#a native#Excel format, but in CSV.
It is very important that no XML or XLS file is uploaded.#When the above example is downloaded, it
is a CSV file.

A#correctly-configured#dynamic dictionary input file looks like this:

example_dynamic_dict.csv

Animal,Place,Says

Cat,Outdoor,Meow

Cat,Indoor,Purr

Cat,Savanna,Roar

Dog,Outdoor,Bark

When this file is used to create a#Dynamic Dictionary, the following is created:
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Individual rows may be added#by clicking the “Add New Row”#button, and#filling out a value for each
column.
 

 

• Columns can only be added when uploading#a#dictionary input file.

Search Filter
The user can search the dictionaries using the Search filter field next to Add New Row button. Type-
ahead configuration in the Search filter, which provides a predictive list of terms based upon user’s
text entry The user can sort the words in ascending and descending order using the arrow next to each
field.

Dynamic Dictionary Best Practices
There are three#major#information theory#paradigms for creating a#Dynamic Dictionary.

• Chained#Terms: Each#value on#row of values will be unique,#occurring#on no other row or
column.

Card#Type,#WidthMM,#HeightMM,#WidthIN,#HeightIN

Poker,#63.5, 88.9,#2.5, 3.5

Micro,#31.75,#44.45,#1.25,#1.75

• Semi-Chained: Some values may be repeated, but these imply no#hierarchy in information on each
row.

Animal,Place,Says

Cat,Outdoor,Meow
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Cat,Indoor,Purr

Cat,Savanna,Roar

Dog,Outdoor,Bark

• Implied Hierarchy:#Arbitrary terms may be used to build a#taxonomic#(nested)#hierarchy.#This
is done by#using each column to define#“clades”#of values#that describe#ever increasingly
specific#description.

Common Name, Domain, Kingdom, Phylum, Class, Order, Suborder, Family, Subfamily, Genus,
Species

Domestic Cat,#Eukaryota, Animalia, Chordata, Mammalia, Carnivora,#Feliformia, Felidae,#Felinae,
Felis, F.#catus

Dynamic Dictionary Field Configuration
Once a Dynamic Dictionary has#been set up, fields will need to be configured to take advantage of
this#dictionary.

When a Dynamic Dictionary is created, the Edit Field#dialog will show#list that#dictionary#not as a
single#entry, but#split into as many sub-dictionaries#as there are columns in the Dynamic Dictionary.
 

 

To make use of these sub-dictionaries, create and configure#a field to correspond to each of them.
Note that these#dictionaries are not hierarchical,#and that checkbox must remainunchecked.

The recommended configuration for Dynamic Dictionary fields is Type Validator:#“Force Dictionary”#&
UI Element:#“String”.#Multi-value fields are not supported, so any of the Type Validator’s#“Comma
Separated” formats are incorrect configuration.

Form Configuration
As always, in order to use fields, they must be included on a Form. This is no different
than adding any other#fields to Forms, and they can be arranged in any order, as there is
no#explicit#hierarchy#insofar as fields themselves are concerned.

It is worth noting that, as always,#with MediaBeacon#Forms,#the#property#settings of#a#field
can be#abstracted from#its#“base” settings in the Edit Field dialog. So, one option for configuring
Dynamic Dictionary fields is to change the Type Validator#and dictionary#assignment in the
Form itself to allow fields to use the Dynamic Dictionary functionality without changing base field
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configuration. If used in this fashion, be sure to only use fields configured as Type Validator: String and
UI Element: String

5.2.3.  Workflow Manager Dialog

Note:  Full section under construction

Visual Workflow Nodes
 

 

Available Conversions
The configuration panel for this node shows conversions defined in the loading dock type that is
currently configured with the admin users ACL. The list presented, however, omits any conversion that
uses the nochange image format.
 

 

Send Email
In previous versions of MediaBeacon#this node#was named “Send Notification”. In 20.0, its name has
changed to reflect that it creates emails, distinct from#the “bell” style notifications of 20.0

Send Notification
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This node allows a visual workflow to send a notification to one or more users as part of the workflow.

• Users to Notify: Allow#one or more#recipients to be specified. Note if
the#Smartname#“[User.Username]” is used, the user who initiated the workflow will receive the
notification. The#User icon button#opens#the Select Users#dialog to choose current active users
ofMediaBeacon

 

 

• Notification#Text: Defines the text to send in the notification.
 

 

Subscribe and Unsubscribe
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These nodes allow an asset that is running through the workflow to be subscribed or unsubscribed#to/
from the listed user or users.

Advanced Workflow Execution Limit
In Advanced workflow, the parameters of the workflows were limited to the Single Execution Checkbox.
When enabled the checkbox, the instance of thread limit was either to have 1 or no limits. Single
Instances of the workflows can create a backlog of items to be triggered and this results in a delay of
workflows to happen.

You can set the workflow thread limits from single execution to 15 times. For example, if the thread
limit is set to 4, then it will trigger 4 threads at a time.

1. Navigate to Manage> Workflow
 

 
2. The Workflow Manager is opened. Select a workflow to make the changes or create a new workflow.

 

 
3. In the Enable Workflow configuration, enable the Execution Instance Limit using the toggle bar. An

option appears to enter the required limit ranging 1 to 15.
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4. Choose the execution instance limit.
5. Restart MediaBeacon.
6. Trigger the workflow.

Note:  The default execution limit is 15.

To enable the changes you have made, always restart MediaBeacon.

If the limit is 1, then restarting is not necessary

5.2.4.  R3Search Dialog

Management of the Solr Admin Interface.

The Menu Bar > Manage > R3Search command opens the Solr Admin UI. MediaBeacon automatically
configures this interface, so there are no changes that need to be performed in this interface to
change MediaBeacon function.

For reference, the documentation for this interface can be found at: https://lucene.apache.org/solr/
guide/6_6/using-the-solr-administration-user-interface.html

5.2.5.  System Status Dialog

A dashboard for various system performance interfaces.

Health
This section details the Health of MediaBeacon server.

The administrator can run tests and get the output. The status of Database, Disk I/O, Remote Systems,
XMP and Anti virus software detection is displayed and the tests can be initiated separately using Run
Tests button and together using Run All Tests.

Workflows
The Workflows section details the different workflows.

Workflow Triggers
The Workflow Triggers details the list of various workflows which have been triggered.

• Scheduled Triggers

• Interval

• Minutes

• Daily

• Hourly

• Asset Based Triggers

• Client- side Triggering
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File Action Queue
The section details the list of the File Action in Queue.

Preview Queue
The section details the list of the Files with its process status.

API Keys
This section details the list of MediaBeacon REST API keys. It gives the details of the API keys
command which are executed, along with the name of the user who executed the command and also
displays the expiration date of each executed API keys.

The Administrator can create a new API key using the Create API key icon below the API status page.

Refer https://www.mediabeacon.com/en/api-documentation#latestDocs to read more about
MediaBeaocn REST API keys.

Filtering API Keys
The Api keys added can be filtered using the Filter Api Keys field in the System Status. The user can
find an Api key without surfing through all the pages. The user can type in a word, number or symbol
and by hitting enter, it returns all the Api keys having the same word, number or symbol in its User
Name, Name, Expiration Date and Api Key.

The filter API key field to search an API key by user, key name, expiration.
 

 

You can also find and sort Api keys ascending or descending by using the arrow next to User Name,
Name, Expiration Date and Api Key. Sometimes the user needs to click on each option to view the
arrow.

This will help a user to find an API key in a system which has hundreds or thousands of API keys.

External Links
The section details the list of External Links with its share details.

Users
The section details the list of Users and their last activity.

Statistics
This section displays the statistics of MediaBeacon's Assets, Users and System.
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Download Configuration
This button enables the user to download the current MediaBeacon configuration. This helps the user
to troubleshoot issues with MediaBeacon Customer Care.

Logs
Logs section in MediaBeacon System status contains the details of various system performance logs.

• Preview System Log
• Remote Log
• Global Log
• Request log
• Web Server Log
• Workflow Log
• R3seach Log
• Solr Log

The common properties of logs contain

• Download logs: This button enables the administrator to download each log.
• Load all: Hovering over this button displays the total size of each log and the administrator can load

all logs of the particular section by clicking this button.
• Filter: Filter tab can be used to search logs using any value.
• Sort: Info is the default sort value. The administrator can select from the drop-down list to sort the

logs. The sort option available are

• All
• Finest
• Fine
• Finer
• Config
• Info
• Warning
• Severe

5.2.6.  External Plugins

The External Plugins command is displayed under the Manage menu when MediaBeacon’s license
includes the option for the Microsoft and/or Adobe connectors, allowing access to the External Plugins
dialog.
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Disabling Display of Plugin Sections
If there is a need to hide one of these sections, the following system properties may be used.

• Disable display of Microsoft Oce Add-In section in the External Plugins dialog:
mb.disable.oce.plugin=true

• Disable display of the Adobe Connector section in the External Plugins dialog:
mb.disable.adobe.plugin=true

Disabling Download of External Plugins
If there is a need to suppress only the download button for either or both of these connectors, the
following system properties may be used.
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• Suppress download of Microsoft Add-In: mb.disable.oce.plugin.download=true
• Suppress download of Adobe Connector Add-In: mb.disable.adobe.plugin.download=true

5.3.  Component Configuration

Options for Configuring Components.

MediaBeacon allows administrators to add a wide array of components to workspaces. Each
component has its own end user and administrator articles, detailing configuration and usage. Below is
a list of existing components.

116



5MediaBeacon

Component configuration changes are now tracked in Metrics.

 Components of Greatest Use

The following is a list of the most-used components in MediaBeacon.

1. Quick Search
2. Search Status
3. Search Filter
4. Directory Browser
5. Infinite Scroll View
6. Tile View
7. List View
8. Cart
9. Conversions
10. Upload HTML
11. Places Browser
12. Form Stamper
13. Featured Content
14. Form

5.3.1.  Using Components on Workspaces

Adding, removing, arranging and sharing components on workspace layout zones.

Adding Components to a Workspace
The components resident to any given workspace can be added by either:

• The Manage Workspace dialog, see below.
• Loading a component asset (.mbwidget).
• Sharing a workspaces between ACLs. See the Using Workspaces on page 84 article for more

information.

When new components are added, they typically appear in the left-hand layout zone, and shared ones
appear in the bottom layout zone. components can be moved from these initial locations.

See Manage Workspace Dialog on page 76 for information on the Manage Workspace dialog.

Adding Components via the Manage Workspace Dialog

In the component sections of the Manage Workspace dialog, components may be added to the
current workspace by clicking the "Add" button under each component section.
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• Single-instance components: Workspaces may contain only a single instance of this type of
component.

• These components will display a "Remove" button under a component's entrywhen on
the current workspace. Clicking this button will remove the component form the current
workspace.

• Multi-instance components: Workspaces may contain any number of this type of component.

• These components will display a count indicator to the right of the "Add" button.
• Note: Removing multi-instance components cannot be done in the Manage Workspace dialog.

Loading a Component Asset
A component's current state may be saved to a component asset that allows the component to be
copied onto other workspaces. Components added via this method are are not "linked" or "shared", but
separate instances of a component.

Create
1. Enter admin mode.
2. Open the configuration dialog for a given component.
3. Expand the "Share component with other workspaces" section.
4. Click the "Export component to asset" button.
5. The asset (.mbwidget)will be downloaded to the administrator's desktop.
6. Upload the .mbwidget asset into MediaBeacon.

Load
1. Right-click the asset and choose "Load Component".
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2. Component is added to the current workspace.

Note: If the component being loaded is a single-instance component, and the current workspace
contains one of that class of component, it will not be added.
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Sharing Components Between Workspaces

Components can be shared across different workspaces, similar to the way that workspaces
are shared across ACLs. In this state, known as "component linking" the settings of the shared
component is the same on every workspace on which it appears.

A component is shared in the "Share component with other workspaces" section of its configuration
dialog (accessible via the gear icon displayed on each component in admin mode.)

 

 

• Checked box, Gray text: The component is resident to this workspace.
• Checked box, Black text: The component is currently shared with this workspace.
• No check, Gray text: This component may not be shared with this workspace. This is due to

another instance of a single-instance component being resident on that workspace.
• No check, Black text: The component is not currently shared with this workspace.

Component Linking and Component ID

When the "Preserve Component Links" option is used to duplicate workspaces, all components on
the new workspace are linked to the ones on the old workspace.

The mechanism that controls this the "Component ID", which can be seen in the "View Preferences"
section of a component's configuration dialog.
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The Component Linking function is discussed in detail in the [Managing Components] section, but
to summarize this feature: Component linking allows components with identical "Component IDs" to
share the same configuration.

Custom Component ID
The Component ID can be altered to a set string, maintaining this ID if the workspace is exported and
shared. A locked padlock icon indicates the ID is stable.

This feature cannot be used to "sync" a component with a pre-existing custom ID. If the administrator
enters an already used ID, a dialog is displayed that says "Cannot set the component id to that value.
That value is already used with another component."

Removing Components from a Workspace

When components are removed, they will be permanently deleted unless they are shared with
another workspace, or have been saved as a .mbwidget asset.

Components may be removed from workspaces in a variety of ways

• When viewing a workspace in admin mode, clicking the "X" button in a component's title bar.

• A toast notification will appear to inform the admin that the component has been removed,
which also presents an "Undo" button.

• This gives the admin 10 seconds to revert that change, after which the component is
permanently removed.

• Unchecking a component in the "Share component with other workspaces" section.

• This removes components on other workspaces.

Layout Zones

The layout area of each workspace allows components to be placed into discrete regions, called
layout zones. In admin mode, these are indicated by a darker background and a gear icon in the
upper left corner.
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Most components can be placed in any layout zone, and will expand or contract to fit the width of
their containing zones. Some exceptions to free layout zone placement are:

• Some components have a "Menu Bar Mode", that fix their positions to preset areas on the page:

• Quick Search
• Search Status
• Cart

• View components may only reside in a special "view component zone". However, other types of
components may be placed above, below, or between them in this zone.

• This is usually the center middle zone in any given layout, but other layouts may have a
different location for the view component zone.

Arranging Components

Components can be moved, while the user is in Admin mode, by click-dragging the title bar of the
component.

• The body of the components in the current layout zone will snap closed.
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• The title bar of the dragged component will become transparent during the drag.
• While in this state, the component may be moved to another layout zone or rearranged with

respect to other components in the current layout zone.
• The new position indicated by a blue outline. When the user releases the mouse button, the

component will be placed in the blue outline and the body of components will again be shown.
 

 

Layout Zone Settings

Layout zones themselves have settings that affect the look and visibility of components. The Layout
Zone Settings dialog is displayed when the gear icon in the upper right of a layout zone is clicked.
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• Background Color

• The controls the background color of the layout zone, which is normally transparent

• Toggleable Components

• This option lists the current components contained in the layout zone with a checkbox for
each. When checked, only one "toggleable" component can be viewed at a given time in a
workspace.

• Clicking a closed title bar will collapse the title bars of other toggleable components and open
the clicked component.

• Clicking the title bar of an open, toggleable component will collapse the clicked component,
other toggleable components remaining unchanged.

• Note the toggleable option is not available for View components, as they have an auto-
toggling feature shared between other view components.

In 2019.1, the "toggleable" setting will override a non-View component's "Hide Component Title"
setting, hiding it in the Configuration dialog.

The "toggleable" setting is per layout zone, and setting a component to toggleable in one zone does
not make is toggleable by default when moved.

5.3.2.  Information Components

Below details various Information Components of MediaBeacon. (Some components are under
construction.)

• Login: This component displays a Login form.
• Logo: This component displays a high resolution image for branding a page. Refer Logo Component

on page 124

• Loading Dock Status: Component for displaying the contents of the loading dock. Also has global
loading dock actions. Refer Loading Dock Types Workspace on page 62

• HTML: Component displays HTML markup as well as MediaBeacon wiki markup.

• Upload HTML: Displays HTML markup as well as MediaBeacon wiki markup. Users can drag and drop
files onto the component to upload

• Form: This component displays a Form and tracks either the current selection or the single
selection, displaying information accordingly.

• Report: A component to give reports on certain points of data such as number of users or total
asset size.

• Search Status: This component allows a user to view and remove any filters applied to the current
view.

• Video Playback: This component leverages an HTML5 video tag to play videos back to back.

Logo Component
This component makes use of the Icon Picker to display an image wherever components are placed.
Refer Icon Picker Dialog on page 125
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The View Preferences and Share Component tabs are similar across all components. Please refer
Component Linking and Component ID and Sharing Components between Workspaces in the Using
Components on Workspaces article for more information.

Configuration
• Logo Image: Opens the Icon Picker, allowing the user to choose an image to display.
• Logo Position: Determines whether the image will be displayed in left, center, or right justification

within the logo component.
• Max width: The pixel value entered here directly limits the width of the image.
• Max height: Located under the View Preferences tab, this property will limit the height of the

displayed image.

Note:  The image will always be displayed in its original aspect ratio.

Note:  The image will not be scaled above its original size.

Icon Picker Dialog
This dialog is used in many places throughout MediaBeacon’s interface. It allows users to add an image
as an “Icon”, that can then be used as a display element in various parts of the UI.

This includes:

• User Account Icons, via the Contact Information dialog

• Only shows thumbnails that the user themselves uploaded.

• Manage Workspace dialog:
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• Home Button Icon
• Dark Theme Home Button Icon
• Workspace Icon
• Workspace Background Image

• Component configuration:

• Metadata Stamper component icons
• Logo component
• Places Browser icons

• Admin Core

• ACL icons
• Loading Dock conversion preset icons

The icon picker is accessed wherever below icon is displayed.
 

 

Clicking it will open the “Pick a photo” dialog.
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Contact Information Icons
Also called “profile icons”, MediaBeacon 21.07 displays the icons that have uploaded by the users prior
in the system as icons.
 

 
If there are no icons present in the Icon Picker, this means that there are no images uploaded by the
user and needs to upload a new image.
 

 

Choosing an image here will use it in the associated UI context, as well as display the thumbnail in the
Icon Picker icon’s place.
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The user may revert the icon to its unassigned state by clicking “Reset Photo”.

Uploading New Icons
Users may upload a new icon by clicking the “Upload” button. The limitations for this icon:

• No larger than 2 Megabytes.

• The icon picker has a limitation of 2 MB for an uploaded image. This can be altered with the
system property “mb.max_thumbnail_size”, and defining a number of bytes as the limit for icon
upload. This is not recommended, as it can affect page responsiveness and load times.

• No specific pixel x pixel limitation, but the recommendation is to upload icons that are the exact
size needed for display, or if larger, only exactly double displayed size. This will reduce blurriness
due to scaling.

• Formats: JPG, PNG (supports transparency), GIF (does not support animation).

Uploaded Icons
Each icon can be removed by hovering the cursor over it, and clicking the “X” pop-up button. There is no
confirmation, and this deletion is final.

General Users are prevented from deleting icons when their ACL includes the “Thumbnail Deletion”
permission restriction.

If a given icon that is in use is deleted, a broken image icon it will be displayed in the UI until a new icon
is reassigned.

5.3.3.  Search Components

Below details various Search Components of MediaBeacon. (Some components are under
construction.)

• Color Search: Uses the R3Search back end to search assets based on the colors inside them.
• Directory Search: The directory browser displays the file system as a tree, allowing users to view

assets by their position in the file system. Granted appropriate permissions, users can add, move,
rename, copy, or delete folders.

• Graph Search: Visually drill down on asset metadata.
• Featured Content: This component displays content from an arbitrary source with paging.
• Metrics View: Component which displays MediaBeaconusage metrics. Adding this component to

a workspace will cause only metrics data to be displayed on the workspace. No searching of data
beyond the metrics core is possible until this is removed.

• Places Browser: This component holds Places that can be arranged and organized in a folder
structure tree. A Place is a shortcut to a specific ACL, workspace, directory, saved selection, saved
search, or hierarchy tree link.
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• Quick Search: his component searches assets by filename (case-sensitive) and the MediaBeacon
ID number by default. The MediaBeacon administrator can enable additional fields or types of
metadata to be available for searching.

• Saved Searches: Shows a panel with saved searches from the user and any searches the group
members have shared.

• Saved Selections: Shows a panel with saved selections from the user and any selections the group
members have shared.

• Filter Search: This component uses R3Search to display the frequency of all values for selected
metadata fields. This component allows a user to filter assets based on the metadata values. The
values available are dynamically updated based on active filters.

• Refinement Search: Provides information on which metadata fields contain your most recent
search terms, and allows you to further focus your search by field and term.

• Tag Cloud: Create a tag cloud from values in any solr indexed field.
• Taxonomy Browser: This component allows browsing by hierarchical metadata fields. The taxonomy

fields available are setup in the user or group administration pages.

Places Browser Component
The Places Browser component is used to provide function shortcuts to the user in a variety of
different presentations. A shortcut, or “place” can redirect a user to specific ACL, workspace,
directory, saved selection, saved search, and more. These places can be displayed as a in a number of
ways: a collapsing tree, a pull-down Menu, buttons, or as tile squares.

Places Preferences Tab
 

 

• Heading title text: This text is displayed at the top of the list of places in all display modes.
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• Display Mode: This chooses the display mode of the places defined in the Places Browser tab (see
below). Note that not all place types can be displayed in every Display Mode. See each Place Type for
these restrictions.

Display Modes:

• Tree: Displays places as a “folder tree”
• Menu: Displays places as a multi-level menu
• Button: Displays places (including nested places) as buttons
• Tile Square: Displays places with larger icons, and in a regular grid, up to 4 columns wide
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• Show Folder Filter: This option is only present in Tree Display Mode. It displays a filter field above
the list of places, which filters the displayed trees.

Place Types Configuration
In general, each item under the Root Place generates a static place in the Places Browser. Some places
do have Dynamic functionality such as the Directory place or the ACL List place.

Common Properties
These properties Perform the same function per place and are described here for brevity.

• Display Name: Defines a place’s label in the Web UI.
• Add a thumbnail: Defines the places icon in the Web UI. Uses the Standard Icon Picker. If no custom

thumbnail is defined, a place will use the standard folder icon.
• Destination Workspace:

• An optional setting for some place types that redirect a user to another workspace in addition to
those places’ regular function.

• No redirection occurs until a workspace is selected via the pull-down menu.
• A defined workspace may be cleared with the “X” button.
• If a workspace is defined that is not available to a given user’s current ACL, the place will

redirect them to the leftmost workspace in their current ACL.
• It is incumbent upon the configuring Global Administrator to understand what workspaces the

users of this place have access to prevent misconfiguration.

Root Place

The “root” place is the containing element of other places. It only becomes a Web UI element for users
if the Places Browser is in Menu Display Mode. In this state, it is displayed as a menu header that is
clicked to show the Places Browser as a pull-down menu.
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• Common Properties: Display Name, Add a thumbnail.

ACL Place

Creates a place that changes the user's current ACL, in the same manner as an ACL listing in the user
menu.
 

 

• Common Properties: Display Name, Add a thumbnail, Destination Workspace.
• Available ACL's: The value chosen in this pull-down field defines the ACL a user will be redirected to

when the ACL place is clicked.

• If a user does not have access to the defined ACL place, the current ACL will be reloaded.
• The list of ACLs available in this pull-down menu are those available to the Global Administrator

who is configuring the component, NOT the list to which any given General User would
necessarily have access. It is recommended therefore, that a Global Administrator be a member
of all Groups/ACLs that would need to be defined as ACL Places (or simply all of them, if
feasible). It is incumbent on such a Global Administrator to have an understanding of which
users will be exposed to this Place and what the disposition of their ACL memberships are.
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ACL List Place

This place generates a dynamic list of the ACL's currently available to the user, appearing as individual
places. One limitation is that custom ACL icons are not inherited, instead all ACLs on the list inherit the
icon of the ACL List Place itself.

Figure 15: List of ACLs generated by the ACL List Place. Note, the “ACL List” row
with the gray background is a Header Place, for aid in labelling the list of ACLs.

• Common Properties: Display Name, Add a thumbnail, Destination Workspace
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Figure 16: The ACLs as listed in the User Menu. Note that ACL icons are not inherited by the ACL List Place.

Directory Place

A Directory Place is used to provide access to specific folders and optionally, their contents. Clicking
on a Directory Place will set the folder’s location as the current search criteria, as though it was
selected in the Directory Browser, although no directory browser component needs to be present.
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• Common Properties: Display Name, Add a thumbnail, Destination Workspace
• Directory Chooser: Highlighting a directory here sets the directory place’s “root” directory. This set

the directory the place will use.

• ACL Root Considerations

• Directories are assigned as an absolute path, and not relative to a user’s current ACL Root
Path. This means that to a user who does not have access to the assigned directory, such a
place will be grayed out and nonfunctional.

• When a Global Administrator is assigning a directory to a Directory Place the “Index”
Directory will match their current ACL Root Path. For this reason, it is suggested that Global
Administrators use an ACL that is unrestricted while configuring directory places.

• It is incumbent upon a Global Administrator to be aware of the ACL Root Paths of the
intended users of Directory Places, so that directory assignment will be functional for all
those users.

• Show Directory Children:
 

 
When enabled, a Directory Place will display its subordinate directory structure when the
folder spin-down icon (a triangle icon to the left of a directory’s icon) is clicked. This includes all
subdirectories.

Header Place

 

 

A header place generates a nonfunctional label that serves to separate places. It is only visible in the
Tree Display mode.
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• Common Properties: Display Name, Thumbnail

• Unlike other places, a header does not have a default icon, but can be assigned one if desired.

• Font Color: Defines the font color header place’s display name.

• Divider color: Defines the background color of the row in which the header place is resident.

Hierarchy Place

Note:  To provide users with click-to-search-functionality, it is considered best practice to use a Filter
Search component rather than a set of hierarchy places.

Hierarchy Places perform a search for a predefined dictionary term in a hierarchical dictionary field.
Each Hierarchy Place searches for a single term.

 

 

• Common Properties: Display Name, Add a thumbnail, Destination Workspace.
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• Select a Field: This property defines the field that will be searched. Only Hierarchical Force
Dictionary fields are listed.

• Select a Value: This property defines the value that will be searched from the extant values in the
dictionary attached to the field as defined above.

JavaScript Place

This place executes a predefined block of JavaScript.
 

 

• Common Properties: Display Name, Add a thumbnail
• JavaScript Block: Defines the JavaScript executed upon click.

Divider Place

The divider place will display a row with a one-pixel high divider line in it in Menu and Button display
mode.
 

 

• Divider Color: Defines the color of the dividing line.

Workspace Place

This place redirects the user to a given workspace.
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• Common Properties: Display Name, Add a thumbnail, Destination Workspace.
• Clear Search: When enabled, this option clears the search criteria upon workspace change.

Saved Search Place

This place loads a given saved search.
 

 

• Common Properties: Display Name, Add a thumbnail, Destination Workspace
• Search Within Current Results: If this option is checked, a saved search place will add its search

criteria to the current search criteria, rather than replacing it.
• Available Searches: This field defines the saved selection used for this place.
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• Note:  It is considered Best Practice to use Admin Saved Searches for Saved Search Places
since they cannot be changed by general users.

Saved Selection Place

This place loads a specific saved selection, which may be either be a User Defined Saved Selection
or a MediaBeacon default, such as “Last Upload” or “My Cart”. Additionally, the number of assets in the
selection will be automatically be displayed in parentheses to the right of place’s name.
 

 

• Common Properties: Display Name, Add a thumbnail, Destination Workspace.
• Available Selections: This field defines the saved selection used for this place.

Workflow Place

 

 

• Common Properties: Display Name, Add a thumbnail, Destination Workspace
• Workflow to execute: This field defines the workflow that is executed when this place is clicked.

• Note:  Only Visual Workflow, or a JavaScript Workflows that the “Enable Client-Side Triggering”
property enabled are selectable in this list.
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Note:  If a user’s ACL contains the Permission Restriction “Trigger Workflow”, They will not be
able to execute any workflows regardless of Places Browser configuration.

Places Browser Tab
This tab allows the administrator to configure the list of places in the browser.

Places are structured in an arbitrary hierarchy, each place being able to contain any number of other
places. The functionality of places is not affected by their arrangement inside other places.
 

 

In an unconfigured state, this tab shows:

• The Root place: This is the containing object for other places, it is normally not displayed, except in
Menu mode.

• Add Place button: when clicked, this button displays a contextual menu that lists all the types of
place that can be added. When adding places.

• Delete Place button.
• The Place Configuration panel: This area shows available configuration properties of the selected

place. Places have some properties that are unique and some common to all places.

Adding and Removing Places
• To add a place, click the “+” button and choose a place from the menu. The new place will be added

as a nested item under whichever place was selected. If no place was selected, it will be added
under the root place, at the end of the list of top level places.

• Note:  When adding places to a places browser for the first time, the Global Administrator may
need to spin open the Root place to see newly added places. So it is generally advisable to click
the root place before adding initial places.

• To remove a place, select it and click the “X” button in the upper left corner of the place list.

• Note:  Newly added places will not appear in the places browser unless they are fully configured.
That is, the main option for that place type has been configured (such as selecting a saved search
for use in a saved search place) AND the name is changed from the default display name.

• Note:  When changing the names and icons of places in the Places Browser Configuration Dialog,
those changes may not display in the Configuration Dialog until after the “Save” button is pressed
OR the Global Administrator clicks on another place and then back to the just-edited one.

Reordering and Nesting Places
Places may be arranged into arbitrary hierarchical structures using drag-and-drop to reorder or nest a
place within another. Only one place may be dragged at a time.
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• Drag and Drop onto Sibling Place: When a place is dragged-and-dropped on top of another place
that is a sibling of the dragged place (that is, on the same level in the hierarchy), a “Warning” dialog is
displayed.
 

 

• Nesting: Clicking “Move” will move the dragged place into the target place. It will be
automatically nested into that target place, at the end of the list of any extant places.

• Reordering: Clicking “Reorder” will rearrange the order of places. Whether the dragged place will
be ordered before or after the target place is contingent on its previous position. If the dragged
place had been above the target before the drag, it will be positioned below the target once
dropped, and vice versa for the converse case.

• Drag and Drop onto Non-sibling Place: If a place is dragged-and-dropped to a target place that is
NOT its sibling, it will be automatically nested into that target place. This includes the Root Place.

Quick Search Component
 

 

The View Preferences and Share Component tabs are similar across all components. Please refer
Component Linking and Component ID and Sharing Components between Workspaces in the Using
Components on Workspaces article for more information.

Filtering Options Tab
Destination Workspace field sets a target workspace to which the user will be redirected when a
search is performed in the Quick Search component.
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Options Tab
 

 

• Menu Bar Mode: Disabling this checkbox causes the Quick Search component to operate as a
regular component. It will be “undocked” from its normal place on the workspace, will appear in the
Layout Area, where it can be moved to any desired Layout Zone.

• Note:  It is recommended that if the Quick Search is put back into Menu Bar Mode, it should be
in the left layout zone column first. This is because this layout zone is the default location in the
page structure for a Quick Search component even when displayed in the Search Bar area with
the Menu Bar Mode option.

• Show Advanced Search: When enabled, this option displays the Advanced Search button. See the
Advanced Search Dialog section for more information on Advanced Search functionality.

• Change Placeholder Text: By default, the Quick Search field displays “Search” until the user begins
entering text. The string here will replace that default value.

Search Options tab
MediaBeacon allows various search options for the user. You can configure these options by checking
the boxes beside each option.
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Show Alternatives
When enabled, this option enables the Alternatives Menu in the Quick Search field. This menu is hidden
until a search has been performed. This menu displays sections for values in dictionaries that closely
match the current search criteria. It will display Synonyms, Spelling and Thesaurus entries, which spin
down to show values from those columns of dictionaries.
 

 

When one or more of the terms’ checkboxes are enabled, the user my then click “Search” and those
terms will be added to the current search criteria.

Search Synonyms & Search Thesaurus
When enabled, this allows entered search criteria to return assets that are tagged with synonym (and
or thesaurus) terms. There are two ways to implement this behavior: duplicated synonyms and non-
duplicated synonyms.
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• The duplicated synonyms model assumes that dictionary will duplicate some values in a dictionary’s
Word/Spelling field, using them to populate the synonym field of another entry.

Figure 17: Duplicative dictionary

Note:  “crimson” is listed under Words and Thesaurus.

• The non-duplicated model assumes that no Word/Spelling field value will match any synonym field
value in that dictionary.

Figure 18: Non-Duplicative dictionary
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Note:  Using the non-duplicative model is vastly more popular option and is considered a best
practice. Keep in mind that to use this model properly, the dictionaries must be set up correctly and
the “Bidirectional Searching” option MUST be enabled. Using this model better enforces controlled
vocabulary, preventing terms proliferation and misuse.

Bidirectional Searching
As stated above, this allows non-duplicative dictionaries (the best practice) to be used with synonym
searching.

Note:  This options is DISABLED by default, and is almost always needed for expected synonym
searching behavior.

Use R3Search for typeahead suggestion engine
This option enables the typeahead function, using values that are currently written into assets on
R3Search Indexed fields.

Use dictionary for typeahead suggestion engine
This option enables the typeahead function, using values found in all dictionaries in the system.

Search Refining Options Tab

Note:  To enable this option, it is required that the tab itself be open when “Save” is clicked on the
Configuration dialog.

 

 

The Search Refining option is similar to the standalone Search Refining component. When enabled,
when a string is entered in Quick Search, and a comma or return are entered, the term will be
surrounded by a capsule element, and a drop-down menu will be displayed.

In the Search Refining Menu, the relative frequency of assets that contain the term on a given field is
shown as a small bar graph.
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The “Global” entry displays how many assets contain the term in all fields. In this example, the value
“scenic” appears to only exist in the keywords field, indicated by the global and keywords entry showing
the same relative proportion of assets.

• Only include fields with name mappings in refining options: This option is deprecated and has no
function in MediaBeacon v20.x and higher.

Dictionaries Tab
Dictionaries chosen in this multi-value selector define the dictionaries that Are used for synonym
searching. By default, all dictionaries are used (per the All Dictionaries Selection) but individual
dictionaries can be chosen from the selector. The All Dictionaries selection clears individual dictionary
assignments. If this selector is left blank, synonym searching will not function.

File Name Search Operand Tab
 

 

By default, Quick Search searches file names, using the “Contains” setting, meaning that the entire file
name is searched, including file extension. This tab’s other settings can change the matching criteria:

• Is: Filenames must be an exact match for the entered search string.
• Begins With: Filenames must begin with the exact entered search string.
• Ends With: Filenames must end with the exact entered search string, including file extension.

Fields To Search Tab
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This option, left blank by default, changes the Quick Search component’s behavior. Normally Quick
Search returns results from all indexed fields, indexed text, and file names. When the Fields To Search
pull-down is populated with one or more fields, the Quick Search will be limited to returning results on
only the specified fields instead of all indexed fields.

Saved Selections Component

• Show selection filter: This option toggles the display of the filter field from the top of the saved
selection component.

• Exclude selections with prefix: When enabled, the entered string is used to hide saved selections
containing that string in their names.

Note:  Note that this filtering is done as a prefix, so it will only filter saved selection names that
have the specified string at the beginning of their names

The View Preferences and Share Component tabs are similar across all components. Please refer
Component Linking and Component ID and Sharing Components between Workspaces in the Using
Components on Workspaces article for more information.

Metrics Component
Metrics Component displays MediaBeacon usage metrics. Adding this component to a workspace
will cause only metrics data to be displayed in the workspace. Using this component on a workspace
dedicates it to the metrics functionality.

This component’s functionality is changed by other components and changes the function of other
components, specifically the Filter Search, and the results shown by any View Component.

As such, it is best to add a “Metrics” workspace (via the Add Workspace dialog) so that other properly
configured support components are present.

Filter Search Dependencies
• Field Switcher: This list shows the fields which can be used with the stack graph function. This list

is determined by the Facets defined in the workspace’s Filter Search. In addition, the stack graph
function only works with fields from the “MediaBeacon Metrics” schema. Please see the Appendix
for a listing of these fields.

• Number of X-Axis Terms Displayed: X- Axis Values: The number of values displayed is dependent on
the Filter Search’s “Number of Results”.
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Metrics Component Configuration
 

 

The Metrics component has no configurable options.

The View Preferences and Share Component tabs are similar across all components. Please refer
Component Linking and Component ID and Sharing Components between Workspaces in the Using
Components on Workspaces article for more information.

5.3.4.  Action Components

Below details various Action Components of MediaBeacon. (Some components are under
construction.)

• ACL Selection: Shows the available ACLs in a panel which the user can select. Refer ACLs

• Cart: This component allows a user to drag assets from a view component, such as Tile View, and
drop them into a cart. A cart can be saved as a new selection or be set as the current selection.
Refer Cart Component.

• Conversions: This component allows for assets to be sent to the loading dock for processing. It can
also be added to the action palette at the bottom of the page. Refer Download Conversions

• Metadata Stamper: This component allows a user to create an Form stamp that can be used to
easily update assets' metadata.Metaform Stamper

• Navigation: Component to display workspaces in some form. Used to navigate to different pages
within MediaBeacon.

148



5MediaBeacon

• Trash: A component to drag items onto to delete them.

5.3.5.  View Components

Below details various View Components of MediaBeacon. (Some components are under construction.)

• Infinite Scroll View: View component which displays a page of assets with scroll. Once bottom of
scroll is reached, a new page is added to the bottom of the container, so the user can keep scrolling
to new pages.

• List View: Spreadsheet style text view with Editable XMP Metadata.
• Tile View: Displays a tile view of assets.
• Video Editor View: Component for creating/editing videos from video files in the repository.
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View Components Overview
View components allow the visualization of assets in several different formats. They also provide
access to asset manipulation functions.

Figure 19: Infinite Scroll View

Figure 20: List View

Figure 21: Tile View

Figure 22: Video Editor View
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Delete Icon: Shown on each component, in Admin Mode, this button  will delete that given
component on the current workspace. Note that shared instances of this component are not deleted
by this action.

View Component Fast Switcher: Users can switch between View component by clicking the icon
shown in the View Component Fast Switcher that corresponds to each View component present on a

given workspace. 

Renaming Components: In Admin Mode: The title text of a component may be changed by double-
clicking it in Admin Mode, and entering alternate text, and confirming the change by pressing return.

Shared Vs Non-Shared View Component Configuration: View components on the same workspace
are never in a “shared” state with other view components (even of the same type) on that workspace.
For example, if a particular Highlight configuration is used in a given Infinite Scroll component, another
Infinite Scroll component on that workspace would need to have the settings for Highlights matched
manually in order to coincide with the first.

Filter Headers
Filter Headers are displayed above the View component’s list of assets. They can be used to sort and
filter results. The fields displayed and other Filter Header properties can be configured in Admin Mode.

The options dialog to configure each View Component’s list of Filter Headers is displayed by clicking

the Options icon, shown to the left of Filter Header field names (while in Admin Mode), in
the upper left of a View Component.
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Filter Header Configuration Dialog

• Select a field: To add a given as a Filter Header, click on “Select a field” and choose from the drop-
down. If a field is greyed out, this indicates is not indexed in SQL. This does not have a significant
performance impact on the system, it is simply informational.

• Select Form: Choosing a Form here will add all fields on that form as filter headers.

• Fields to Display: This area displays currently added fields and their arrangement, top-down
corresponding to left-right, and allows each Filter Header to be configured. Setting Filter Header
Order: Fields can be rearranged by placing the cursor to the left of the field name.
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• When the hand cursor changes to a moving cursor then, drag the field to the desired place.
 

 

• Removing Filter Headers: To remove a filter header, click the “X” button to the right of a field
name.

Clicking on a given field’s name will display per-field configuration below the “Fields to Display” area.

Note:  Additional Filter Headers are most useful on the List View, as the data therein is displayed to the
user.

Filter Header Configuration Options
When configuring Filter headers, each field has a number of properties configurable. When the
name of a specific Filter Header is clicked, in the “Fields to Display” area, the options for that field are
displayed below the “Fields to Display” area.

The nature of these properties can vary depending upon the Type Validator and UI Element of the field.
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String & Multi-value Fileds

 

 

Numeric Fields Options

• Field Calculation: This feature is displayed for all field types, but only had function on the numeric
fields (Integer, Positive Integer, Real Number, Positive Real Number, Large Number).
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• When a particular calculation is selected, the results are displayed in a row at the bottom of the
View component.
 

 

• Sort Results: This sorts the result by its relevance or numerically.
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• Dynamic Ranges: When “Dynamic Ranges” is selected the administrators will be able to define their
own ranges.

String & Multi-value Field Options

• Default Conjunction: Sets the Default Conjunction used between terms selected in a Filter Header
menu.

• Number of Results: Limits the number of values shown initially in the “Filter Terms” section of a
Filter Header Menu.
 

 
• Sort Results: Assets’ sort order is set here, by either Relevance (frequency), Alphabetical and

Reverse alphabetical.
• Max Scroll Height: This feature is deprecated, and has no effect.
• Date Field Header Options
• Dynamic ranges (Today, last month, etc.)
• Display as hierarchy (not currently functional in Filter Headers)
• Display as calendar (not currently functional in Filter Headers)
• Color for frequency (not currently functional in Filter Headers)
• Start Date: This option allows to choose the starting date.
• End Date: This option allows to choose the ending date.
• Gap: The gap between the assets’ Date Entered can be selected from the following options:

• 1 Month
• 3 Months
• 1 year

Apply Sort Order
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This section of the field properties enables a “default sort order” to be set for the View component.
When enabled default sort order for a particular field, select Apply sort order and choose the field from
the drop-down Order by list.

• Enable: This toggle enables the sort order off and on.
• Order By: This sets the field by which the View component’s assets will be sorted.
• Sort Ascending: Sorts the View component’s assets in ascending order by the chosen “Order By”

field.
• Sort Descending: Sorts the View component’s assets in descending order by the chosen “Order By”

field.

Infinite Scroll View Configuration
 

 
The View Preferences and Share Component tabs are similar across all components. Please refer
Component Linking and Component ID and Sharing Components between Workspaces in the Using
Components on Workspaces article for more information.

General Options Tab
 

 

• Pinpoint results: When a search is performed, Pinpoint results allows the user to choose the
"Pinpoint" command from an asset’s contextual menu.
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This will display a pop-up dialog which details what metadata matched the search criteria.
 

 
• Assets Draggable: This feature allows assets displayed in the View Component to be dragged and

dropped onto other parts of the MediaBeacon Web UI to perform a variety of functions to those
dragged assets.

• Enable find like assets: This feature allows the user to find assets which have similar properties.
Selecting this enables the user to choose the ‘’Find similar assets’’ command from an asset’s
contextual menu.
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When the user clicks the command, the top 5 colors in that asset’s color profile histogram become
search criteria.
 

 

• Show selection size: This feature will add the total disk space that the current asset selection
represents in the asset count indicator in the Selection Bar.
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• Wrap File Name: This feature wraps long, otherwise truncated file names to multiple lines.

• Show Squared Assets: This feature displays the assets in the View Component as cropped to fit in
a square tile.

Search Filtering Options tab
 

 

• Default Search Filter: A saved search designated in this place will add search criteria whenever the
View component is loaded (either by the workspace containing it is loaded or, it is switched to via
the Fast Switcher). Note that this configuration option does not prevent these added search criteria
from being cleared.

• Mandatory Search Filter: This feature enforces the selected saved search all the time. In this case,
the user does not have an option to clear the mandatory search.
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• Clear all pre-existing search criteria on mandatory search change: The default behavior of
MediaBeacon is to retain search criteria when the user switches between different workspaces
or view components. This option will clear all non-mandatory search criteria when this view
component is displayed.

• Hide Mandatory searches: This feature hides the mandatory search criteria from being displayed in
the Search Status component, while still applying those criteria.

Advanced Options tab
Advanced options provide a way to create custom landing pages for different search conditions.
 

 

• Custom View If No Asset Found: This feature allows the administrator to add a custom text
message when there are no assets found on the workspace.
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The message can be added in the form of HTML or WYSIWYG mode using Change HTML edit mode
icon.
 

 

• Jump to Workspace if a Search returns no results: This feature takes the user to a specified
workspace if there are no results on the performed search. The administrator can select the
workspace from the drop-down list.

• Run JavaScript on Page Load: When this feature is enabled, the administrator can configure a
JavaScript to execute while the page is loading.

Highlight Config tab
Highlighting of asset previews can be configured using Highlight Config tab. If the metadata matches
the desired criteria, a colored notch in the left corner will be displayed in the asset preview. Highlights
can also be configured to display a badge with an icon.
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To add highlight, click the Add Highlight button.

Enable by Criteria: The administrator can enable highlighting assets by adding criteria. More criteria
can be added using Add Highlight button. A criterion can be deleted using the delete icon next to each
criterion.

Note:  Keywords can be added in terms of hierarchy.

 

 

Enable by JavaScript: The administrator can enable highlighting assets by adding a Code search in
JavaScript.
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Highlight Color: The administrator can select a custom highlight color from the drop-down.

Note:  Best practice is to select any color other than transparent.

Enable badge: This feature displays a badge in the asset preview.
 

 

• Badge Icon: This feature allows the administrator to upload a custom badge icon.
• Badge Title: This feature displays an optional label alongside the badge icon.
• Enable the badge on hover: The badge is displayed only when you hover over the asset.
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• Enable Drag and Drop on Badges: This feature will trigger a badge’s JavaScript when assets are
dropped on it.

• Enable JavaScript Action: This feature allows the administrator to enter JavaScript that will be
triggered when the badge is clicked. Note: The user should respond to triggered action before any
other actions.

Fields Displayed Below Asset tab
The administrator can add different fields to be displayed on the asset preview from the drop-down
list. File name is the default field displayed.
 

 
 

 

Enable Drag and Drop File Upload tab
This feature toggles the user’s ability to drag-and-drop files from their desktop to the View component
to Upload.
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• Standard Directory: This feature sends the uploaded files to the standard upload directory.

• Current Directory: This feature sends the uploaded files to the current directory.

• Which directory do you want the files to upload to? This feature lets the administrator to set a
custom directory for drag and drop uploads.

• Link to Target Asset: This feature allows the users to automatically link to an asset on upload by
dragging their files onto it. Administrators have the option of requiring that users fill out specific
form during upload linking, which can differ from required forms during normal drag and drop
upload.
 

 

Tile View Configuration
 

 

Most of the options for the Tile View component do not differ from similarly named Infinite Scroll View
component options. Please refer to that section for more information.

Significant differences to Tile View component options are listed below.

General Options tab
• Enable View Resize Slider: The display of the thumbnail resize slider may be toggled here.
• Default slider value: This slider sets the default size of asset tiles in the component. Note: If the

above option is enabled the user will be able to change asset tile size, but only for that user.
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List View Configuration
 

 

Most of the options for the List View component do not differ from similarly named Infinite Scroll View
component options. Please refer to that article for more information.

Significant differences to List View component options are listed below.

Highlight Config Tab
Same as the Infinite Scroll View component, but Highlights on a List View component cannot have
badges.
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List View Options Tab
 

 

• Enable Import: When this feature is selected, the Import button in the list view is enabled for the
users.

• Enable Export: This feature enables the Export button for the users.

• Enable Bulk Edit: This feature enables the Bulk Edit button for the users.

• Capture current component settings and block: When this feature is selected, the current
component settings of the ACL is made default.

• Is Read Only: When this feature is selected by the administrator, the ability of users to edit the
fields in the list view is disabled.

• Preview Size: The administrator can select the size of the list preview.

• Number of rows to display: This feature allows the administrator to enter the number of rows to be
displayed.

• Width: The administrator can set the display width of the list view in pixels. If there are many fields
in the list component, the View component will add a scroll bar for navigation.

Video Editor View Configuration
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The options here do not differ from the Infinite Scroll View component’s options. Please refer to that
article for more information.

5.4.  Brand Portals

The brand portal feature is a refinement of several existing and new components and functions in
MediaBeacon, that, together, present an introductory interface that guides users to content.
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The workspace above is configured as a brand portal. This article will cover the specific configuration
points used.

5.4.1.  Adding a Brand Portal

A generic brand portal may be added to an ACL via the Menubar > Create > Workspace command, which
opens the “Add a Workspace” dialog, where the admin may choose click the Brand Portal preset.
 

 
A new workspace will be added, preloaded with the appropriate components. However, these will need
to be configured to fully style the portal. One additional point to note is that all components on this
template have their “Hide Component Title” property enabled.

5.4.2.  Configuring Brand Portal

Navigate to Manage> Workspace> Workspace Options> Styling Options
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• Hide Menu Bar

• Typically, the menu bar is hidden from the user on a Brand Portal.
• Home Button Icon

• When a custom Home Button Icon is configured, any Quick Search component that is not in
Menu Bar Mode will display that icon to the left of the search field.

• Workspace Background Image

• This “icon” is used as a static background for the workspace. Previously this functionality was
achieved using the Featured Content component

• Home Destination Workspace

• This field allows an admin to configure the Home Button (which normally clears search criteria)
to redirect the user to a given workspace.

• This function can be still performed by using the Client JavaScript method “changeWorkspace”
in the Manage Workspace > Workspace Options > Advanced JavaScript Options > “Enable
JavaScript on Home Button Click” section. Note that commands entered here will supercede the
setting in “Home Destination Workspace.”

• As a best practice, this configuration would not likely be used on a brand portal workspace itself,
but would likely be used on other workspaces to provide an easy way to return to the brand portal
workspace.

5.4.3.  Brand Portal Component Configuration

This section details the component configuration points used in a Brand Portal.
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Logo Component Configuration Points
A new component that uses the Icon Picker to quickly configure a static image for display.

Quick Search Component Configuration Points
• As mentioned above, a custom Home Button Icon is configured, any Quick Search component that

is not in Menu Bar Mode will display that icon to the left of the search field.
• When in this state, the menu bar is displayed slightly taller (48px tall), than the base state (40px).

Places Browser Component Configuration Points
• Tile Square Mode (New, Places Browser Configuration > Places Preferences > Display Mode)

• This place display mode is a re-imagining of places in Button mode that was used with Landing
Pages. When used, it reveals a set of options per place that are used specifically in Tile Square
mode.

• Background Image: Uses the icon picker to assign a background image to a place tile.
• Dark Theme Background Image: The same as above, but uses a unique image when the dark

theme is used.
• Background Color: This setting allows the admin to define the background color of the tile.
• Text Color: This setting allows the admin to define the text color of the tile.

• If a place’s Tile Square settings are not configured, each place will be displayed in a randomized
distinct color form other tile squares.

Note:  Dark Theme Background Image icon will be enabled only when the Display mode is set to
Tiles in the Places Browser configuration. In other scenarios, only the Background image icon will be
displayed.

Featured Content Component Configuration Points
This component allows the admin to define a set of live assets in a paginated display to the user. When
the user clicks on any of these assets they may be redirected to another workspace.

• Content Source (Existing): A content source must be defined for the assets shown in featured
content either by saved selection or saved search.

• Display Modes (New, Featured Content Configuration > Configuration > Display Mode): In previous
versions of MediaBeacon, there was only one display mode available (Landing Page Mode), this is
now augmented with two new display modes, which replace the need for and the function of asset
Custom Layout.

• Tile Square: Displays each asset without its name fitting within a square tile (showing the center
of the asset).

• Tile Fit: Displays each asset and its name in a tile element similar to asset presentation in
MediaBeacon’s Tile view component.

• Number of Rows (Existing): Defines the number of tiles shown vertically within the featured
content component.

• Destination Workspace (Existing): Defines the destination workspace used when a user clicks
on an asset within the Featured Content component.
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HTML Component Configuration Points
• Background Mode (New, HTML Configuration > Configuration > Background Mode)

• This option, when enabled will tint the background of an HTML component with a 50% white fill.
This provides a simple method of making text in the component contrast to the background.

• As a best practice suggestion, if the Advanced HTML Composition mode is in use, “Display
Contents in an Iframe” option should be disabled when the HTML component is being used to
show simple text.
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6.  Add-on Functionality Configuration
In this section you can read how to configure Add-on Functionalities in MediaBeacon.

6.1.  External Portals

This feature allows Global Administrators (or properly privileged General Users) to create#a#styled
portal that allows#visual#access to assets for#non-users of MediaBeacon. The#portal contains a
selection of assets that may, searched and#downloaded (if the portal settings allow).

This feature’s UI is comprised of

Note that the External Portals function requires additional setup of an AWS S3 bucket to operate.

• the#Menubar#> Create > External#Portals#command
 

 

• the#Menubar#> Manage > External Portals command
 

174



6MediaBeacon

 

• the Create External Portals dialog
 

 

• the Manage External Portals dialog
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• the#Portal UI itself
 

 

Note:

• ACL Permission Restriction: This feature is enabled by default for all users of an#ACL but#may
hidden by using the “External Brand Portal” permission restriction

External Portal Default Graphics
The default Logo, Banner and Favicon of new portals may be set using the following system properties.
The Images that are used are not resident in MediaBeacon as assets, but at a given location on the host
server. Note: This location is arbitrary and is specified the system property.

The following system properties set the default images for new portals.

mb.external_portal.logo.path=C:\\Users\\Administrator\\ExternalPortalDefaults\\logo.png

mb.external_portal.banner.path=C:\\Users\\Administrator\\ExternalPortalDefaults\\banner.png

mb.external_portal.favicon.path=C:\\Users\\Administrator\\ExternalPortalDefaults\\favicon.ico
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The following system properties prevent users from changing the images for new portals.

mb.external_portal.logo.locked=true

mb.external_portal.banner.locked=true

mb.external_portal.favicon.locked=true

Note: These properties and files must be used on the webhead server as well (in the
catalina.properties file).

6.1.1.  Using an External Portal

• Portal#Quick#Search:#Clicking the#Magnifying#Glass icon will switch the title bar to a search
field. This function is analogous to#Quick#Search in MediaBeacon. It will#search available
metadata fields and file names for the entered string.#Search may be cancelled by clicking the
“Back” arrow button.

Note:  External portal quick search is case sensitive.

 

 

• Portal Infinite Scroll View: This view is the default#for the#portal and#may be chosen with the
second#to#the#rightmost button#in the title bar.

• Portal Tile View:#This view allows the user to see the filename and included metadata for each
asset. This view may be chosen with the rightmost button in the title bar.
 

 

• Portal Asset View:#Similar toMediaBeacon’s#Asset#View, clicking on an asset will show a higher
res preview of the asset (if possible) and available metadata.#Paging between assets is also
possible with the left and right icons#that hover on the edges of the preview.
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• Downloading Assets: Assets must be selected via the selection icon in each asset’s upper right
corner before downloading.#Once an asset is selected, the title bar will show#the Clear Selection
button (X icon), the#Selection Count, the Select#All button,#and the Download Selection icon.
 

 

Portal Asset View
The users can open single asset view in the external portal and can paginate through the assets using
the arrow keys.
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6.1.2.  Creating an External Portal

To create an External#Portal,#select one or more assets in a View component, and
choose#Menubar#> Create > External Portals, which displays the#Create#External#Portal#Dialog.
 

179



6 MediaBeacon

 

• Create Portal:#This radio button#is#displayed#(and#auto selected)#when an asset#selection is
extant when this dialog is opened.#It allows new portals to be created.

• Republish Portal: Expired portals may be republished when this button is chosen. The user may
modify all parameters of the portal except the included assets (Asset List).

• Asset List: Displays the#assets#that will be used in the portal, derived from the selection of assets
at the time the dialog was opened.

• Name:#The name for the portal. This will be displayed as its tab name in the browser.

• Description: A description of the portal, not shown to the user.

• Expiration Date: Automatically set to a week from the current date, this is the date the portal will
automatically be unpublished and unavailable.#Once a portal has expired it will be automatically
deleted.

• Allow Downloads: Allows users of the portal to download the assets in the portal. The original files
are downloaded

When an External Portal is created, creator gets notification.

A given General User will be able to see those view portal entries in the Manage Portals dialog (Manage
> External Portals) that they created, or created by users in ACLs that the given user is also a member.
Global Administrator users are still able to see all External Portal entries in this interface.

180



6MediaBeacon

Asset Retention Policy
In#External Portals, whenever a user downloads an asset, the cache of downloaded files is stored.
The default value set is 50GB (previously it was 24 hours). User can download again using this cache
instead of pulling files from the core file system. If the size of downloads causes the total cache size to
be greater than the set value, the older files will be automatically removed until the cache size is back
under the set value.

6.1.3.  Customization Options

• Static Images
 

 

• Banner: None / Custom: This image will appear above the Portal’s Action bar.

• Logo: Default (MediaBeacon) / Custom: Replaces theMediaBeacon Logo with one of the user’s
choice.

• Favicon: Default / Custom
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• Fields to Display: One or more fields may be chosen to display in the portal’s Tile and Asset views.
Note that the list of fields available here are those available#to the ACL in which the Portal is
created.

• Sharing: Allows an email to be sent, showing a To field, where the user can enter an e-mail address
or name, or can choose the recipient from the list.
 

 

The e-mail recipient will get a default e-mail with

• Email subject: “A selection of assets have been shared with you by [$user]”.
• External Portal name
• External Portal description
• Number and the total size of assets in the External Portal.
• External Portal Expiration Date
• Access Portal button

External Portal Default Sharing E-mail
Unlike previous versions, in the Sharing section of the External Portal dialog, the users can choose a
name from the existing users or e-mail address to which the link “Access Portal” will be sent.
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6.1.4.  Managing External Portal

 

 
The Manage Portals dialog is opened when a user chooses#Menubar#> Manage > External Portals. In
this dialog, each row represents a live, accessible portal

• Name:#Portal’s name
• Creator: The user who created the portal
• Expiration Date: The date the portal will automatically become unavailable
• Creation Date: The date the portal became available, during this current publication
• Description:#Description of the portal
• Copy URL button: Copies the#portal’s URL#to the user’s clipboard
• Open URL Button: Opens the portal in a new browser window/tab
• Republish Portal#button:#Allows the portal’s details to be updated, including expiration date#and

other details. See the Reusing Portals.
• Unlike previous versions, external portal can be sorted according to its name, creator, creation date

and expiring date

External portals now track who they were shared with based on the email addresses on portal creation.
 

 

Republishing Portal
Portals may be “republished” to assist with two use cases:

• recycling an expired portal
• editing the properties of an existing portal

The user can replace or update the set of assets used in a preexisting or expired external portal. There
are two ways to republish a portal:

Create Portal dialog
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1. Open the External Portal dialog via Menubar > Create > External Portal.
2. Choose “Republish Portal”.
3. In the Select External Portal field, choose a portal to republish.

 

 
4. The dialog is now in the republishing mode.

Manage Menu

Open the Manage External Portal dialog via Menubar > Manage > External Portal

To republish a portal, the user can select Menubar > Manage > External Portals and then choose the
Republish Portal Icon.

1. Original Assets: Uses the already existing assets in the portal.
2. Current Selection: Uses the currently selected assets in the portal.
3. Original Assets and Current Selection: The assets from the Original and Current selection are

used.

For example, the below external portal contains these images:
 

 

• Select additional assets from the workspace which needs to be added along with the current
assets.

• Click Republish Portal > select the option Original and Current Selection.
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• Click Republish Portal.

The user can see all the assets in the republished portal.
 

 

6.1.5.  Reusing Portal

A portal’s publishing status#may be extended by “republishing” the portal before the expiration date.
This may be done:

• In the Manage Portals dialog, with the#Republish Portal button,

OR

• Opening the Create Portal dialog without an asset selection being made,
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OR

• Choosing “Republish Portal” in the Create Portal dialog.

6.1.6.  External Portal History

History of the actions taken in External Portals is now recorded in MediaBeacon History (Manage >
History). The actions recorded are:

The “External Portal” History item has been added. This records when an asset is published via an
External Portal, or when assets are in a republished External Portal.
 

 

6.2.  MediaBeaconConnectors

Learn how MediaBeacon Connectors extend the capability of content creation software.

6.2.1.  Adobe® Connector

Integrate MediaBeacon into Adobe® products.

• The Adobe Connector now supports check in check out

• Right click the desired asset.
• Select the action to be performed.

• The Adobe Connector now allows the user to specify the directory location for new asset uploads.

• The Adobe Connector Tasks now have a search bar to filter on tasks, and thumbnails are shown for
task documents.

• In the Tasks section of Adobe connector, the user can find the files quickly by the option to search
them automatically by the image browser.

The Adobe® Connector is an add-on product that enablesMediaBeacon functionality within some
Adobe® products. The Connector requires Creative Cloud 2018 or newer, and works with InDesign®,
Photoshop®, and Illustrator®.
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Main Capabilities
The Connector allows users to:

1. Search for assets stored in MediaBeacon
2. Place images into layout documents directly from MediaBeacon without a separate download step.
3. Place FPO images (low-res temporary images), and all FPO links with the original images in one step.
4. Edit assets without a separate download step.
5. Automatically upload placed images when layout document is uploaded intoMediaBeacon.
6. Upload new files or versions of changed files to MediaBeacon from within an Adobe® application.
7. Create and automatically upload PDF proofs to MediaBeacon.
8. Automatically replace a local file with a more-recently updated one, stored in MediaBeacon.

Limitations
• Not all Adobe® applications will have the same feature set with the Connector.
• Fonts are not managed by the Connector.
• Placed .csv files (used for Data Merge in InDesign®) are not managed by the Connector. CSV files are

also not shown in the Connector asset browser.
• Folder structure of placed images is not preserved when uploaded to MediaBeacon, instead they

are put in

<cachefolder>/<aclfolder>/uploads/<user>/<datestamp>/links/

Terminology
For clarification, several terms used in this article will be defined here:

• Assets: Files stored in MediaBeacon.
• Layout document: A generic term for either an InDesign® or Illustrator® document, especially one

that contains placed images.
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• Placed images: Often referred to as "links", these are files that are referenced or "placed" in a
layout document. The full data of these images are not copied into the layout document, but are
referenced when the layout document is printed or used to generate a PDF. Layout documents will
include a low-resolution preview of the image used for on-screen placement, but this is typically not
suitable for print-resolution output.

• Local cache: This refers to a folder on an end user's computer that the Connector uses as a cache
for files synced with MediaBeacon. This area contains layout documents, images, and other files
uploaded or downloaded via the Connector.

Connector Basics

Managing the Connector Panel
The Connector acts as another panel in the Adobe® application interface. Once installed it may be
added to the current workspace with the following steps:

1. In an Adobe® application, from the menubar, choose Window > Extensions > MediaBeacon.

a. On macOS, this can also be done by choosing "Help" and entering "MediaBeacon"
2. The Connector window will display as a free-floating panel.
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3. To "dock" the panel, drag the panel tab to the edge of a window docking area, such as the right hand

toolbar. A blue edge will be highlighted, indicating it will be inserted horizontally adjacent to the
current menubar.
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Note: Because the Adobe® workspace UI is very flexible, the panel may be docked anywhere any
other panel may be, see the "Manage windows and panels" section of the given Adobe® application's
User Guide.

• InDesign: Manage Windows and Panels

• Illustrator: Customizing Workspacee

• Photoshop: Manage Windows and Panels

Logging into MediaBeacon via the Connector
• The Connector allows the user to enter the URL for a MediaBeacon server when displaying the

"MediaBeacon URL" screen.
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• The URL entered must include http:// or https://

• The easiest method is to copy the URL from a browser window while logged into MediaBeacon.
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• The user will enter username and password, and when authenticated, the plug in panel will be
displayed in "logged in" mode.
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Logging out of MediaBeacon via the Connector
1. Select "Logout" from the User Menu.
2. The Connector's panel displays the "MediaBeacon URL" page.

Connector User Interface
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1. Directory Panel Toggle: This button opens the folder browser, showing the folders and Saved
Selections available in the current MediaBeacon ACL.

Figure 23: Toggle Button

Figure 24: Directory Panel opened

a. Directory tab: When spun open, this area displays the folders on the DAM to which the user has
access. When a folder is selected, the asset browser will be filtered to show contained assets,
and a path indicator is also displayed. Clicking the circled "X" button will clear that folder filter.
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b. Saved Selections tab: When spun open, this display 3 further tabs of saved searches (Shared,
Private and Public). When any of those categories are spun open, a list of saves searches are
displayed, and upon clicking one, the asset browser filters for only the assets in that selection.
Note: when a saved selection is loaded, the search bar is not shown.
 

 
2. ACL Menu: Allows the user to choose an ACL to which they have access in the MediaBeacon system.

This allows the user to view and use assets accessible to that ACL.
 

 
3. Language Menu: Changes the language of the Connector interface.
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4. User Menu:
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a. Logged in as: This row in the menu displays the current logged in user.
b. Clear Cached Assets: This command will display the number of files resident in the connector's

local cache folder. When clicked, the connector will remove all files in this folder.

Note:  Files removed via this method are immediately deleted.

c. Preferences: Low Resolution Mode: This function is explained in detail below.
d. Reload Connector: This command will restart the connector within the current Adobe®

application.
e. Logout: Disconnects the Connector from the logged-in user'sMediaBeacon account.

5. Search Field: A simplified QuickSearch field. Strings entered here search all metadata in the
current ACL's assets.
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a. Clear Search Button ("x" icon): This button clears the current search.
b. Magnifying Glass Button: Clicking this button, or pressing the return key will execute the quick

search.

Note:  Clicking the magnifying glass button when the quick search is empty will reload the
assets in the connector's Asset Browser.

6. Advanced Search: When clicked, this shows a simplified advanced search row. This allows the user
to specify a Field and a Value to search for within all ACL assets.
 

 

a. Field: Allows the user to select a XMP field to search within. Entering text here will display a
pulldown with XMP fields that match the entered string.
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b. Value: Allows the user to enter a search value.

a. Search Filter in Value Field: When a XMP field is chosen, clicking or placing the cursor in this
field will show a pulldown menu with values existing in that field, as well as a count of assets
containing that term.
 

 
b. This function is similar to the search filter in the MediaBeacon Web UI, but is not as

comprehensive. Each advanced search row's fields do not filter values shown in subsequently
added rows.

c. Clear Search Row Button ("x" icon): This button removes the adjacent search row.
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d. Add Search Row Button (+ icon): This button adds a search row.

 

 
7. Asset Browser: Similar to MediaBeacon's Infinite Scroll component, this area shows all assets that

are the results of the search terms above. See the Connector Browser Functions section for more
information.

8. Asset Menu: This icons allows the user to open a pull down menu to perform two commands to a
given asset.
 

201



6 MediaBeacon

 

a. View in DAM: This command opens a browser window to display the asset's Asset View. This
requires the user to login via the browser if not already authenticated.

b. Upload as New Version: This command allows the active document (if in a saved state) to be
uploaded as a new version of an asset.

Note:  "Upload as New Version" menu command vs. "Upload New Version" button:The menu
command is considered a secondary function, useful when the user wishes to upload a new
document as a document version. In most cases, the "Upload New Version" button will be
preferable.

9. Buttons: These perform actions based on the state of the active document. See the Connector
Button Functions section for more information.

10. Loading Bar: This progress bar is shown when the Connector is uploading an asset to MediaBeacon.
 

 

Connector Button Functions
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Upload
This button is displayed when the active document is saved locally, but is not present inMediaBeacon.
Once the upload button has been pressed, the document is synced to the local cache and MediaBeacon
through the following procedure:

1. The active document is automatically saved and closed.
2. The document is copied into the local cache.
3. The document is uploaded to MediaBeacon.
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4. Finally, the local cache copy of the document is automatically opened. This is the new working copy
of this document. The initially saved document may then be discarded.

This button is displayed if all of the following are true:

• The active document is saved to user's local disk.
• The active document isn't recognized as a MediaBeacon asset.

Upload New Version
This button is displayed when the current layout document is currently saved and is recognized as an
asset currently residing in MediaBeacon.

When clicked:

1. The New Version dialog is displayed, allowing the user to add a comment to the version.
 

 
2. Once the "OK" button is pressed, a new version of the asset is uploaded into MediaBeacon. See the

Versions section of the MediaBeacon User Manual for more information.

Using this function keeps the local and MediaBeacon copies of documents in sync.

This button is displayed if all of the following are true:

• The active document is saved to user's local disk.
• The active document is recognized as a MediaBeacon asset.

Export PDF
This will automatically create and upload a PDF of the current layout document toMediaBeacon. This
PDF is created using the "Press Quality" preset.

This button is displayed if all of the following are true:

• The active document is saved to user's local disk.

Up- Res
This button is displayed when one or more placed images in the active document are in a "low-res"
state. A numeral in the button name indicates the number of placed images in this state.

This state can occur for several reasons:

• An asset has been placed in the active document, but the full resolution version has not been
downloaded. See the Placing MediaBeacon Assets section for more information.
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• The FPO function was used while placing an image from MediaBeacon. See the FPO Function
section for more information.

Clicking this button will begin the process of downloading the "full-res" (the original) version of the
asset to the local cache.

This button is displayed if all of the following are true:

• The active document contains placed images that end with the thumbnail marker.

• <filename>.thumbnail.jpg

Update Links
This button is displayed when one or more placed images in the active document have been modified
in MediaBeacon, or the placed image does not exist in the local cache. A count of placed images with
broken links are displayed in the button text.

When the "Update Links" button is pressed, the Update Links dialog will be displayed. See the Update
Links Dialog section for more information. Several changes to a placed image can cause this button to
be displayed:

• The locally cached placed image has been deleted or moved to another directory on the end user's
computer.

• In this case, Update Links will re-download the asset to the local cache.

• The placed image asset has been moved to another directory in MediaBeacon

• In this case, Update Links will re-download the asset into the folder structure of the local cache
that reflects the asset's location in MediaBeacon.

• A new Version of a placed image asset has been created in MediaBeacon.

• In this case, Update Links will re-download the current version of an asset.

• A placed image asset has been Replaced in MediaBeacon.

• In this case, Update Links will re-download the asset.

• A placed image asset has been Deleted in MediaBeacon, but is still present in the local cache.

• The assets are removed from the local disk, but the placed image links are left intact to inform
the user where the images used to be.

This button is displayed if all of the following are true:

• The active document is saved to user's local disk.
• The active document is recognized as a MediaBeacon asset.

• There have been changes made to placed images (in the active document) in MediaBeacon:

• Placed images have been deleted in MediaBeacon.

• Placed images have been deleted (or moved from auto download locations in the Cache folder)
on the user's local disk.

• Placed images have been moved in MediaBeacon.

Update Document
This button is displayed when the Connector detects that the currently opened document is older than
the copy stored in MediaBeacon. This occurs when another user uploaded a new version of the asset,

205



6 MediaBeacon

or metadata has changed. The Update Document button will close the currently open document, and
replace it with the version stored in MediaBeacon.

Note:  This function will permanently delete the local cache copy of a document.

The Update Active Document dialog is then displayed, informing the user that unsaved changes to the
active document will not be saved.
 

 
This button is displayed if all of the following are true:

• The active document is saved to user's local disk.
• The active document is recognized as a MediaBeacon asset.
• There have been changes made to the active document (or placed assets used in the active

document) in MediaBeacon.

• Changes that trigger this state can be an update to metadata, or a new version has been
uploaded.

• This function may also be triggered by clicking the asset preview in the Connector asset browser
that corresponds to the currently open document.

Deleted Documents
If an active (open) document is deleted in MediaBeacon, the connector will inform the user that the
asset has been removed. Clicking "OK" does not remove the document, and if the user is still able to
save the document to a local location (such as the desktop) and re-upload if needed.
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Update Links Dialog
 

 

This dialog is displayed when the Update Links button is pressed, or a layout document (that has placed
images which are not in the local cache) is downloaded.

1. The user may choose individual images to download by selecting the checkbox next to each
filename, or the "Select All" button to select all filenames.

2. Once selections are made, the user clicks the "Update" button.
3. The placed images are downloaded to the local cache, and the broken links in the Links Panel will be

resolved.

Connector Browser Functions

Opening Assets
If an asset is a file type that can be edited by the current Adobe® application, single-clicking the asset
will copy it to the user's local cache, and open it for editing.

Opening Layout Document Assets with Placed Images
When the active layout document has placed images that are not currently in the local cache, the user
will be presented with a standard missing links dialog.
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Once the user clicks "OK", the Update dialog will be displayed. See the Update Links Dialog section for
more information.

Contextual Filtering
The view of assets on the Connector's browser is filtered by file type, depending upon the application
that is being used. The MediaBeacon Default "File Format" field data will be used. See the application
sections below for more information.

Placing MediaBeacon Assets
Assets housed in MediaBeacon can be placed directly into a layout document.

Several actions occur in the background automatically:

1. An Asset ID reference is placed. This only occurs in Illustrator. In this case, the Connector
immediately swaps this out for and moves to step 2:

2. A thumbnail image (AKA FPO image) is automatically placed.
3. In the background, the original (aka full-res) version of the asset begins to download to the local

cache.
4. When fully downloaded, the FPO image is seamlessly replaced by the full res version in the local

cache and in the layout document.

To place an asset, the asset may be drag-and-dropped or multiple assets may be clicked to "preload"
them to InDesign's cursor.
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Drag-and-Drop:

1. Left-click, hold and drag from the Connector's Asset Browser to a page region of an open layout
document.

2. Release the left mouse button.
3. When the cursor changes to display an image thumbnail of the image, left-click to place the image

at 100%, or left-click, hold and drag to define the size of the placed image, or drop into an image
frame.
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Note:  When using InDesign®, it is not necessary to 'drag' an image from the connector's asset browser
to the active document. The action is just as easily accomplished with a "cursor loading" action, see
below.

Cursor Loading: When a user has clicked multiple assets in the Connector asset browser, InDesign's®

cursor will indicate a "stack" of assets to place (when moved over the page area of a layout document).

The user may then left-click to consecutively place each image at 100%, or left-click and drag to define
the size of the placed image, or drop into an image frame.

 

 

Note that the assets clicked in the asset browser will show a selected

Loading Bar: When clicked, a thumbnail asset will briefly show a loading bar underneath an
image preview. This is indicating that an FPO (aka thumbnail) image (maximum size 512x512 px) is
being downloaded to be used for initial placement. At the same time, the original asset will start
downloading. This allows the image to be placed without waiting for full image download. Once the
original image is downloaded, it automatically replaces the thumbnail on disk and in the Links panel.

 

 

When very large assets are placed, or the file transfer is slow, the "Up-Res" button may be displayed
while the full-size version of an asset is downloading. This allows the Connector to avoid interrupting
the flow of design work.
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Refresh Asset Browser
To refresh the list of assets:

1. Click the Folder Browser Toggle button.
2. Click the "Index" button.
3. Click the Folder Browser Toggle button.

FPO / Low Resolution Mode
This option allows the Adobe® Connector to always place FPO images, and only download the originals
manually. To use the function, choose the "Low Resolution Mode" in the User Menu.

In this state all downloaded images will initially be "thumbnail" images <filename>.thumbnail.jpg, and
will be automatically replaced and relinked when the "Up-Res" button is pressed.
 

 

The Low-Resolution function's will remain activated (or deactivated) for all supported applications on a
given computer until toggled.

Using the Connector with InDesign®

The Connector's functions as described above are consistent when used with InDesign.

• Asset Browser Filtering in InDesign: "File Format" Equals "Graphics" OR "File Format" Equals
"InDesign" OR "File Format" Equals "PDF"

Using Show Import Options
In order to use the "Show Import Options" InDesign® function with images in the Connector asset
browser:

1. File > Place.
2. In the Place Dialog, enable the "Show Import Options" checkbox.
3. Select a local image, and click "open".
4. Place the image and then remove it.

In this state, any images placed will show import options.
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Using the Connector with Illustrator®

• Adding assets to a layout document must be done with a drag-and-drop, the cursor loading function
is not present in Illustrator. When an asset is clicked, a reminder dialog box will be displayed.
 

 
• EPS files cannot be uploaded.
• Asset Browser Filtering in Illustrator: "File Format" Equals "Graphics".

Using the Connector with Photoshop®

• For clarity, when using Photoshop®, the "Upload" button will upload the active document, as there is
no concept of a "layout document" in Photoshop.

• The Connector cannot be used to place images in Photoshop® documents.
• Photoshop® links are not managed by the Adobe® Connector or MediaBeacon.
• Asset Browser Filtering in Photoshop: "File Format" Equals "Graphics".

6.2.2.  Clarifai® Connector

Use the Clarifai® AI to automatically tag assets with metadata.

Clarifai®

The Clarifai® Connector enables automatic metadata tagging in MediaBeaconfor images or videos.
Assets may undergo the tagging process automatically or manually, and are returned with suggested
keywords, along with a confidence score for each term.

Installation and Configuration
TheMediaBeacon Clarifai® Connector is installed via a licensed package.

Once the package is installed, configure the connection.

1. In theMediaBeacon Web UI, in Admin > Workflows, navigate to the following workflow:

a. Workflow Name: ClarifaiManager
b. For the workflow settings, set these Properties to be relevant to your system and installation.
c. The properties that can be set include:

a. API Key (required).
b. Enabling the Clarifai integration.
c. Choosing the mode prediction mode – general, custom, or both.
d. Setting the minimum probability for keywords to be returned.
e. Enabling video predictions.
f. Enabling writing to Dublin Keywords.
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g. Defining which custom model to use.

 

 

How to Trigger Asset Tagging
Tagging can be triggered automatically or manually.

1. Automatically: The standard workflow triggers can be used to automate tagging of the asset.
Note: When an asset is re-imported and new previews are generated, the asset is re-sent for keyword
predictions.

2. Manually: The "Collect Predictions" box can be checked in the asset Form to manually trigger
tagging of the asset.

Once the asset has been run through Clarifai®, the results will appear in the Keywords field, if writing
to Dublin Keywords is not disabled via workflow property. They will also populate the Values field, along
with the relevancy score. Keywords may be manually removed and added in this form.
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7.  Server Based Configuration
In this section you can read about the server based configuration in MediaBeacon.

7.1.  Single Sign On

If Single Sign On is configured in the Control Panel Gui App (Server-Side), the user will not be able to
reset their password in the Web UI.

7.2.  Global Default Icon

The default icons shown in various interfaces may be changed with a set of system properties:

7.2.1.  Global Icon Key

• “Home” button on workspaces. This still may be overridden by workspace “Home” icon assignments.
• Login Component Logo.
• External Links Logo

These may be replaced with a logo resident in the Icon Picker, and implemented with a system
property: “mb.global.icon.key=UUID”.

Example: mb.global.icon.key=05155BD9-3A93-4AB3-8025-13872B0079D3

To implement:

1. Open the User Menu and select “Manage your Account”
 

 
2. Click the picture icon in the left. This will open the Icon Picker.
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3. In the Icon picker, add a new icon by clicking “Upload?”. A PNG image of a minimum of 252 px X 45 px

is recommended.
 

 
4. Once the icons is upload and visible in the dialog, open your browser’s developer tools menu (usually

Shift-Right Click) and choose “Inspect".
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5. Copy the UUID as listed above.
6. In the mediabeacon.properties and catalina.properties files, add the System Property as listed

above, substituting your UUID.

7.3.  MediaBeacon Port Information for Remote Components

MediaBeacon has a number of remote components that can be used in conjunction with the core
MediaBeacon application. Below are the default ports various components use to connect.

Tomcat Webhead
• Connects to MediaBeacon R3volution core: 44444, 44445, and 44446.

• Connects to R3Search node(s): 30000.

• Connects to Zookeeper(s): 31000.
• Connects to external authentication server, if in use (Active Directory, LDAP, etc.)

Remote Preview Node
• Connects to MediaBeacon R3volution core: 44444, 44445, and 44446.

• Connects to the database.

• Connects to the file system.

Remote Import Node
• Connects to MediaBeacon R3volution core: 44444, 44445, and 44446.

• Connects to the database.

• Connects to the file system.

Remote R3search
• Connects to MediaBeacon core: 44444, 44445, and 44446.

• Connects to R3Search node(s): 30000.

• Connects to Zookeeper(s): 31000.
• Connects to the database.

Remote Zookeeper
• Connects to MediaBeacon core: 44444, 44445, and 44446.

• Connects to R3Search node(s): 30000.

• Connects to Zookeeper(s): 31000., 31001, 31002.

• Connects to the database.
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